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White Pine

Chapter 1
Introduction

Videoconferencing (also known as Video Chat) takes place when two or more
people communicate using video and some combination of audio, text, or graphics.
CU-SeeMeis White Pine' s videoconferencing software for your desktop computer
featuring color video, audio, chat, and data sharing. Y ou can use CU-SeeMe on the
Internet or any TCP/IP network for real-time person-to-person or group
conferencing, broadcasts, and chats. Whether you are an instructor conducting a
training class, a business manager communicating to a customer, or someone
wanting to chat with afriend, you will be amazed at the ways CU-SeeMe will bring
you closer!

In this chapter you will learn where to find information about CU-SeeM e and what
you need to install your software. Y ou will also get an explanation of CU-SeeMe
conference types. Thisis helpful to understand before you begin your first
videoconference.
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Where to Find Information

Where to Find Information

You are starting at the right place! With the help of this User Guide, you will be
videoconferencing in minutes. This book guides you through the process of making
your first connection, enabling you to see and speak with other people. Thisbook also
explains some of the most often used features of CU-SeeMe.

In addition to this book, there are other sources of information to help you use and
enjoy CU-SeeMe:

Online Help

CU-SeeMe comes with online Help, a complete reference tool that includes
step-by-step procedures and additional information about CU-SeeMe that is not
covered in this book.

(Windows)

Windows users can get Help in two ways:

0 You canview the CU-SeeMe Help Contents window by choosing CU-SeeM e
Help Topics from the Help menu. From the CU-SeeMe Help window you can
select Help topics for more specific information.

O You can also get context-sensitive Help by clicking the Help button found in
many dialog boxes and message windows or by pressing the F1 key.

(Mac OS)

Mac OS users can view CU-SeeMe Help topics by clicking the Help menu. Online
Help isdisplayed in a Web browser window. Y ou must have browser software, such
as Netscape Navigator™ or Microsoft® Internet Explorer, to view the online Help.

WhitePineBoard Documentation Online (Windows)

The WhitePineBoard documentation (WPBoard.pdf) contains detailed instructions on
using the WhitePineBoard. Thisis an Adobe Acrobat® file, available when you
perform a Typical Install or select online manuals during a Custom Install.
WhitePineBoard is available only to Windows users.
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Web Pages

See the CU-SeeMe World Wide Web pages (http://www.cuseeme.com) for more
information about CU-SeeMe, including product updates and technical support.

Other Books

For information on Microsoft® Windows®, consult the Windows user guide provided
with your version of Windows from Microsoft, Inc.

For information on Mac OS®, consult the user guide provided with your version of
Mac OS from Apple® Computer, Inc.

Because CU-SeeM e has become so popular around the world, many books have been
written about it. Here are afew:

Enhanced CU-SeeMe by Robert Rustici is published by MIS:Press, ISBN
1-55828-490-7. This book explains the nuts and bolts and etiquette of
videoconferencing with CU-SeeMe.

The Internet TV with CU-SeeMe by Michael Sattler is published by SAMS
Macmillian, ISBN 1-57521-006-1. This book provides an
in-depth look at the freeware version of CU-SeeMe.

Videoconferencing: The Whole Picture by Toby Trowt-Bayard is published by
Flatiron Press, ISBN 0-936648-48-1. This book, a videoconferencing systems and
network buyers guide, thoroughly describes all aspects of videoconferencing.

UOIBWIOJU| PUIH 0} 3I3UM

Windows® and Mac OS® Information

This User Guide provides CU-SeeMe instructions for the Windows® and Mac OS®
operating systems. In most cases, CU-SeeMe worksidentically on Windows and Mac
OS. Whenthere are substantial differences, instructionsfor both operating systemsare
given. If information is not identified as being specific to one operating system or the
other, it is appropriate for both.
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System Requirements

System Requirements

There are many waysto use CU-SeeMe, depending on the hardware and software you
have. If you want to send video from your computer, you need to have avideo camera
and avideo capture card (sometimes referred to as a video digitizer card or an AV
card), or use avideo camerathat does not require acapture card, such asthe Connectix
QuickCam. Y ou can receive video from other users even if you don’t have avideo
camera or avideo capture card, however other users will not be able to see you.

On acomputer running Windows, you need to make sure you have a sound card
installed in your computer in order to send and receive audio. All Macintosh
computers have sound capabilities built in.

White Pine maintains a list of recommended video capture cards, sound cards, and
cameras that work with CU-SeeMe. Thislist is published online in our Frequently
Asked Questions (commonly referred to as FAQs) on the World Wide Web at
http://support.wpine.com/cuseeme.

Minimum System Requirements
To use CU-SeeMe, you need the minimum requirements listed in the following

sections.

Windows

Computer Requirements:

O Windows 95 or Windows NT Version 4.0
0 Pentium processor, 100 megahertz (MHz) minimum
O 16 megabytes (MB) of RAM (24 MB or more recommended)

0 10 MB of hard disk space

Network Connections:
0 TCP/IP (Winsock-compliant), PPP for dial-up connection
O 28.8 Kbps (minimum) modem, LAN, Cable or ISDN connection

O IPaddress
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To Send Video:

0 Digital camera (such as Connectix QuickCam)
- or -

0 Desktop video camera and video capture card

To Send Audio:
O Microphone

O 16-bit (minimum) sound card and drivers

To Receive Audio:
0O Speakers or headphones

O 16-bit (minimum) sound card and drivers
Mac OS

Computer Requirements:

0 Mac OS System 7.6 or later

0 PowerPC processor, 100 megahertz (MHz) minimum

(|

24 megabytes (MB) of RAM (32 MB or more recommended)

O 10 MB of hard disk space

Network Connections:

0 Open Transport Version 1.1.2 or later
0 28.8 Kbps (minimum) modem, LAN, Cable or ISDN connection
O IPaddress

0O PPPfor dial-up connection

Chapter 1. Introduction
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System Requirements

To Send Video:

0 Digita camera (such as Connectix QuickCam)
- Or -
0 Desktop video camera and video capture card (such as Apple AV board)

To Send Audio:

0 Microphone

To Receive Audio:

0 Use built-in speaker, or optional external speakers or headphones
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CU-SeeMe Assistants

CU-SeeMe includes many Assistants to help you accomplish tasks while using the
program. Assistants are step-by-step guides that lead you through a process, such as
creating a Contact Card, creating a Personal Profile and more.

When you have finished installing CU-SeeMe and you run CU-SeeMe for the first
time, the CU-SeeM e Setup Assistant appears. Follow the stepsasit guidesyou through
the process of configuring CU-SeeMe for your first videoconference connection.
Using this Assistant, you will set up your video and audio sources, create
communication settings based on your network connection, and choose whether to
share information to make it easier for other people to contact you using CU-SeeMe.
See “Using the Setup Assistant” on page 2-2 for more information.

Chapter 1. Introduction 1-7
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CU-SeeMe Conference Types

CU-SeeMe Conference Types

When you communicate with someone using CU-SeeMe, your conversation is called
aconference. A conference can include communication using video, audio, text, and
graphics. CU-SeeM e allowsyou to communicate with people using several conference

types:

O Point-to-Point Conference

0 Group Conference

0 Cybercast Conference

O Multicast Conference (Windows only)

Thefollowing sectionswill explain thefirst three conference types, sincethese arethe
most widely-used conferences. To learn more about multicast conferences, see
“Multicast Conferences (Windows only)” on page 3-44.

Point-to-Point Conference

A point-to-point conference occurs when one person conferences directly with another
person. Each person must have a computer running CU-SeeMe. You can be connected
through the Internet or through a private network such as alocal area network (LAN)
or wide area network (WAN). A point-to-point conference isillustrated in Figure 1-1.

Figure 1-1. A point-to-point conference connects two people
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Asan exampl e, suppose you want to videoconference directly with afriend. You would
need to know that friend's Internet Protocol (IP) address. You can then use CU-SeeMe
to call that 1P address and conference with your friend, much like you would dial your
friend’s telephone number if you wanted to connect for atelephone cal. Like a
telephone number, an | P address is a unique numeric identifier except instead of
identifying your telephone, it identifies your network-connected computer. (If you use
an online directory service, you can eliminate the need to know an | P address to make
acall. See “Registering With an Online Directory Service” on page 5-24 for more
information.)

Group Conference

A group conference provides acollaborative environment where co-workers, students,
or wholefamilies can participatein aconference. The most common way to participate
inagroup conferenceisto connect to acomputer running conference server software,
such as MeetingPoint or the White Pine Reflector. Any video, audio, text, or graphics
that you transmit is received by the conference server, then transmitted to al others
connected to the conference. A group conferenceisillustrated in Figure 1-2.

Figure 1-2. A conference server connects a group of people in a collaborative environment

A group conference has an |P address or host name that you use to call it, just like a
point-to-point conference. Some group conferences require a unigque conference ID
number or password to join the conference.

Chapter 1. Introduction 1-9
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CU-SeeMe Conference Types

Cybercast Conference

A cybercast (or one-way conference) is similar to television broadcasting. One
computer, running conference server software, transmits audio and video to all users
who connect to it. The individual users can not send video, audio, text, or graphics;
they can only receive broadcast data. A cybercast conferenceisillustrated in Figure
1-3.

Figure 1-3. A cybercast conference is like a TV broadcast for your computer

Some examples of cybercast conferences are NASA-TV that broadcasts video and
audio about space shuttle missions, teachers who cybercast their lessons to remote
students, and trade shows that broadcast video and audio of keynote speakers.
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White Pine

Chapter 2

Making Your First
Connection

Now that you haveinstalled the CU-SeeM e software and checked to make sure your
computer has the minimum system requirements (see page 1-4), you are ready to
connect to your first videoconference. This chapter will guide you step-by-step into
avideoconference where you will see and send video, talk with other people online,
and exchange Chat text. Once you have taken the “ Quick Start” approach presented
inthischapter and you have participated in your first videoconference, you will want
to try using additional features of CU-SeeMe. In subseguent chapters, you will
discover all the fun and useful ways you can enhance your videoconference
experience.

Remember, if you need more help, it is available online. See page 1-2 for
information on using online Help.
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Using the Setup Assistant

Using the Setup Assistant

Thefirst time you start CU-SeeMe, you will see the CU-SeeMe Setup Assistant. This
helps you set up your computer and prepares you for your first videoconference.

When you installed CU-SeeMe, you were given the option of running CU-SeeMe
immediately after installation. If you chose this option, then the Setup Wizard
appeared automatically. If you did not choose this option, then you must start
CU-SeeMe manually.

Windows

To start CU-SeeMe from the Windows desktop, click Start, point to Programs, point
to CU-SeeM e, then click CU-SeeM e for Windows.

Mac OS

To start CU-SeeMe, open the CU-SeeM e 3.1 folder and double-click on the
CU-SeeMeicon.

When CU-SeeMe starts, the CU-SeeM e Setup Assistant appears, as shown in Figure
2-1.

CU-SeeMe Setup Assistant

CU-SeeMe Setup Assistant

Thiz assiztant will help you setup CU-SeeMe for your computer.

There are five steps to follow.
‘You are on step one.

@ Information to be shared with other CU-S5eeMe users
IEI Help other ugers connect ta you

IEI Drefine pour network, configuration

IEI Drefine your video source

IEI Drefine your audio source

Finizh | Cancel | Help |

Figure 2-1. The CU-SeeMe Setup Assistant helps you prepare for your first videoconference
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This Assistant guides you through five steps, after which you will be ready for your
first connection. The first step will enable you to define the personal information that
you want to share with other CU-SeeMe users. Click Next to proceed. The dialog box
shown in Figure 2-2 appears.

CU-SeeMe Setup Assistant

CU-SeeMe Setup Assistant

Drefine the perzonal information that you want to share with ather
CU-SeeMe users.

Enter your name, -
address, and e-mail. : |_|7 :
This information Eirst Mame: |'illiam Last Name: IF'Inetree
is optional and can our CU-Seehe Name: [ily Your CU-SeeMe Name
be edltEd later- “Your E-Mail: Ipinetree@forest.com 1S the name that
appears when you
City: INashua State: INH MNew Hampshin vl Conference Wlth
Postal Code: |03083 Couritry: IUS United States vl others.

< Back I Mest » I Finizh | Cancel | Help |

Figure 2-2. Define information to share with other CU-SeeMe users

Theinformation in this dialog box is optional. Any information you enter herewill be
available to other CU-SeeMe usersin a conference. Y ou can enter, change, or delete
any of thisinformation at alater time. See “Editing a Personal Profile” on page 3-28
for more information. When you are done entering information, click Next.
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Using the Setup Assistant

Select this to have
your name listed in
a directory service
on the Web each time
you are connected

Y ou are now on step two, as shown in Figure 2-3.

CU-SeeMe Setup Assistant

Thiz assiztant will help you setup CU-SeeMe for your computer.

“Y'ou are on step bwo,

@ Help other uzers connect to you
IEI Drefine pour network, configuration
IEI Drefine your video source

IEI Drefine your audio source

Information to be shared with ather CL-Seete users

Finizh

| Cancel | Help

Figure 2-3. You are on step two

Click Next to proceed. The dialog box, shown in Figure 2-4, appears.

CU-SeeMe Setup Assistant

DirectoryService.

A Directory Service iz an onling listing that lets you find other
ClJ-5eetde uzers and lets them find you. CU-Seete uses Fourld

*r'ou can register yourself with Fourl1 Directory Service.

V' Alwayz advertise on Directory Services Server

“r'our password will protect wour information on the Directory Services server. You can uze the provided Enter your Fourll
pazaword or uze one of your own, Make sure you wiite down this password in a zafe place.

password if you are

“rour Fourl 1 Password: I

already registered

Werify your Fourl1 Pazsword: I

BEegister on Fourld |
Click here to register

on Fourl1 directory
service

< Back I Mest » I Finizh

| Cancel | Help |

Figure 2-4. You can register with an online directory service

Y ou can choose to register and list your name on a Web-based directory services
server. Thiswill allow other CU-SeeMe users to locate you and connect to you. This
isoptional. (To learn more about registering with Four11 directory service, see
“Registering With an Online Directory Service” on page 5-24.) When you are done,

click Next.
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Click here to modify
your maximum
transmit and receive
rates.

Y ou are now on step three, as shown in Figure 2-5.

CU-SeeMe Setup Assistant

CU-SeeMe Setup Assistant

Thiz assiztant will help you setup CU-SeeMe for your computer.

Y'ou are on step three.

Information to be shared with ather CL-Seete users
Help other ugers connect ta you

@ Define your network configuration

IEI Drefine your video source

IEI Drefine your audio source

Finizh | Cancel | Help

Figure 2-5. You are on step three

Click Next to proceed. The dialog box, shown in Figure 2-6, appears.

CU-SeeMe Setup Assistant

Chooze the netwark. type that best describes pour configuration. Y'ou
cah also click on the Custom button to define the maximurn amount of
data sent and received on your network connection.

Click the arrow to

Metwork: LAN T1 And Mare

]

LCustomize... |

display a list of network
types. Choose the one
that best matches your
configuration.

< Back I Mest » I Finizh | Cancel | Help

Figure 2-6. Choose your network type

Using the drop-down list, choose your network type. Y ou must choose a network
configuration type that best matches your network. For example, if you are using a

modem, select the corresponding modem choice.

Chapter 2. Making Your First Connection
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Using the Setup Assistant

Click here to select
your video capture
device or to change
your capture settings.
The default settings
work best for most
users.

Click here to take —————1

your picture and
add it to your Contact
Card.

Click Customize to modify the maximum rates at which you can transmit and receive
data. Thisstepisoptional. The default settingswork best for most users. When you are
done, click Next.

Y ou are now on step four, as shown in Figure 2-7.

CU-SeeMe Setup Assistant

CU-SeeMe Setup Assistant

Thiz assiztant will help you setup CU-SeeMe for your computer.

“Y'ou are on step four,

Information to be shared with ather CL-Seete users
Help other ugers connect ta you

Drefine pour network, configuration

@ Define your video source

IEI Drefine your audio source

Finizh | Cancel | Help

Figure 2-7. You are on step four

Click Next to proceed. The dialog box, shown in Figure 2-8, appears.

CU-SeeMe Setup Assistant

CU-SeeMe Setup Assistant - Video

If you have a camera and if you cannot see poursell, click on the
Device buttan.

— The Contact Card you will publizh to other users

Civok frora 0o ol

aliall; Pletee@bresteom

Take a picture >33 | "FI "FI

< Back | Mest » | Finizh | Cancel | Help |

Figure 2-8. You can see the video that you will send to others
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If you have acamera, you can use this dialog box to test the video image that you will
be sending to others. This dialog box also displays a Contact Card, which islike a
business card or acard in arotary file. It is aconvenient way to present and store
information about a person or place. To learn more about Contact Cards, see “ Contact
Cards’ on page 3-12. To learn more about storing information about yourself to send
to others, see “Creating a Personal Profile” on page 3-25.

Click Take a pictureto add your picture to the Contact Card. Thisis optional. The
resulting card is shown in Figure 2-9.

CU-SeeMe Setup Assistant

CU-SeeMe Setup Assistant - Video

If you have a camera and if you cannot see poursell, click on the
Device buttan.

— The videa you will zend

s '

— The Contact Card you will publizh to other users

® illiam Finstres

WS, M 05003 This Contact Card
includes your personal
picture.

Civok frora 0o ol

aliall; Pletee@bresteom

Take a picture >33 | LFI "FI

< Back | Mest » | Finizh | Cancel | Help |

Figure 2-9. You can take your picture and add it to your Contact Card

When you are done, click Next.
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Using the Setup Assistant

Your microphone
volume is shown
here

Microphone
volume control

Click here to
select your audio
recording device

Select this if you
have a full duplex
sound card
(Windows)

Y ou are now on step five, as shown in Figure 2-10.

CU-SeeMe Setup Assistant

CU-SeeMe Setup Assistant

Thiz assiztant will help you setup CU-SeeMe for your computer.

Y'ou are on step five.

Information to be shared with ather CL-Seete users

Help other ugers connect ta you

Drefine pour network, configuration

Drefine your video source

@ Define your audio source

Finizh | Cancel | Help

Figure 2-10. You are on step five

Click Next to proceed. The dialog box, shown in Figure 2-11, appears.

CU-SeeMe Setup Assistant

CU-S5eeMe Setup Assistant - Audio

The colored indicator will display the level of your microphone input.
Click the Test button to play a sample to ensure that your speakers are

| working and to test the volume. Your speaker volume
— Microphone — Speaker is shown here
*f'ou can adjust your settings by clicking *f'ou can adjust your settings by clicking

on ' Device". Dl Speaker volume

| | | — control
Volume: 'I—JT Yolume: 'I_J—I Click here to select
your audio playback
Device... | Device... Il device
Test .
—n—l Click here to test

L | yourspeakervolume

< Back I Mest » I Finizh | Cancel | Help |

Figure 2-11. You can adjust your microphone and speaker
Use thisdialog box to test your microphone and speaker and make audio adjustments.

When you are done, click Next.
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Y ou have now completed the CU-SeeMe Setup Assistant, as shown in Figure 2-12.

CU-SeeMe Setup Assistant

Figure 2-12. You are now ready to run CU-SeeMe and get connected

Continue to the next section to make your first connection and begin
videoconferencing.
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Getting Connected

Getting Connected

If you are connecting to the Internet using an Internet Service Provider (1SP), you must
be dialed into your ISP prior to starting CU-SeeMe.

CU-SeeMeis aready set up to connect you to a group conference called the White
Pine Cafe. Thisisavirtual cafe where you will meet other people who happen to be
connected to the White Pine Cafe at the same time. These arereal live CU-SeeMe
users, just like youl!

Areyou ready? Let’s begin.

Connecting to the White Pine Cafe

If CU-SeeMeisnot aready running, you must start the program.

Windows

To start CU-SeeMe from the Windows desktop, click Start, point to Programs, point
to CU-SeeM e, then click CU-SeeM e for Windows.

Mac OS

To start CU-SeeMe, open the CU-SeeM e 3.1 folder and double-click on the
CU-SeeMeicon.

The Quick Start & Tips window appears, as shown in Figure 2-13. If the Quick Start
& Tipswindow does not appear when you start CU-SeeMe, go to the Phone Book
Help menu (in Windows) or the Window menu (in Mac OS) and click Quick Start
& Tips.

Click to connect

Quick Start & Tips - CU-SeeMe =] to alive

CU-SeeM

videoconference
e at White Pine Cafe
Internet
' Visi white Fine |- Click to open the
_|— Phone Book
Open Phonebook :I—

'@' Did you know _ _ .

The Participants List in the Conference Room can be = = i i
dizplayed as a series of icons or az a detailed list. To Find a Friend :l__ .C“Ck to find OU"[ who
change the Participants List view, click the Conference = = IS Currently online
Options button, point to General, then click. with CU-SeeMe
Mest Ti .
—l—" Click to test your

video and audio

¥ Show this Welcome Soreen newt time pou start CU-SeeMe Close | Settings

Figure 2-13. The Quick Start & Tips window helps you make your first connection
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Click Visit White Pine. Y our computer now dials the Internet Protocol (IP) address
of the White Pine Cafe. A dialog box will appear, indicating that your computer is
establishing a connection to the White Pine Cafe. Once the connection is made, a new
dialog box appears, as shown in Figure 2-14.

Connection

} Internet

Fleaze choose the conference you want to joir:

0 ACVE [3/5] Generic Medium B andwidth
1 ACVE [4/0] Generic Medium Bandwidth
2 ACVE [0/0] Generic Medium B andwidth
3 ACVE (441) Modem Users conference
4 ACVE [041]) Small High B andwidth

5 ACVSE (0/1) Self Reflect Test

£ ACWSE [0/0) Self Reflect Test

7 ACVSE [0/0) Self Reflect Test

Conference [D: ID Password: I

Cancel |

Figure 2-14. You can choose from a variety of conferences in the White Pine Cafe

This dialog box offers a choice of conferences. Click Join to join the default
conference. The next dialog box tells you that you are connected and then you are
presented with White Pine Cafe’ s Message of the Day, shown in Figure 2-15.

Connection

Internet

MeetingPaint [tm] 3.0.1 Alpha [Mov 191997 11:37:42] -
‘welcome to The “White Pine Cafe MeetingPoint server at 199.94.217.135.

For FAQ's go to hitp://support. cuseeme. com/
THIS SITE 15 G-RATED!

Clothing, including shirts, must be waorn at all imes when displaying video on this
MeetingPoint server.

You are allowed B0 minutes of connect time, after which vou will be disconnected.

Jid]

Figure 2-15. Message of the Day from the White Pine Cafe
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Getting Connected

The Message of the Day is sent by the people who manage the White Pine Cafe
conference, introducing you to the rules of their conference. Read thismessageto learn
about any special rules or conditions relating to this conference, and then click Go! A
new window will appear, called the White Pine Cafe (see Figure 2-16). Thisisthe
Conference Room window where videoconferencing takes place. Think of it asa
virtual meeting room where you see and talk to others, and share written messages and
graphics. Whenever you connect to a person or place, you will work in a Conference
Room window, similar to this.

«  White Pine Cafe Conference [3] M= E3
MeNnUS ————— Fie Edt Confersnce window Help
] eor] ]
Toolbar IEI ~ g% g; 7 !
Phore Book  whiteboard Video Speak Ta Custamize Hang Up
oo &)
= [ =) o
= () |\ .
o o) o Video windows
Bill = [T 1 o
.. Guillaume e o)
Participants Kaltina N
List Ehis B
Jacques )
[ — S| || Phik: | love this latest version of CLSeelg! =l
— Heidi: My kids use it 10 chat with their friends after school. .
M ] Ton |use it at work for group meetings. Chat window
Willy: We're always reeting nev peopls on the Internet!
H 1 Bill: [ just doswnloaded the latest version frorm hipivevicuseerne.com,
Audio —m8 — Speaking to everyone #nd [ found & list of cybercast svents too! This is so cool.) j
controls and ——
indicators @ —— | CTES
Bill spoke last ICU on the Net!
Status bar Fush o speakc =

Figure 2-16. The Conference Room window is where you see and talk to others

The Conference Room isdivided into several sections, asshown in Figure 2-16. If you
have a camera connected to your computer, you will see your video picturein one of
the video windows. If other people are connected to the White Pine Cafe, you will see
their names listed in the Participants List. Y ou will also see video images of some of
these people. For example, in Figure 2-16, Heidi, Bill, Tom, and Phil are other people
who are in the cafe. Additional participants, such as Forrest, Guillaume, Katrina, and
others are also in the cafe but their video images are not currently displayed on your
screen. When you are connected to the White Pine Cafe, you will not seethe samelist
of names as shown in Figure 2-16 because you are connected to a changing group of
real people. Thelist of participants will be different each time you connect. The
number of video images you see depends on the type of network connection you have,
the number of participants in the conference, and the video layout selected. See
“Changing the Layout of the Video Windows" on page 4-23 for more information.
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Y our name appears in the Participants List as CU-SeeMe User (Local). CU-SeeMe
User isthe default name assigned by CU-SeeMe. Y ou can choose a different user
name by defining anew user profile. To learn how to do this, see“Creating a Persona
Profile” on page 3-25. The word (Local) is added to your name to indicate that it is
being sent from your computer. Y ou are the local participant. Other people in the
conference are remote participants. In Figure 2-16, Willy is the name of the local
participant.
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Seeing Other People

Seeing Other People

2-14

When the Conference Room opened, video images of some of the people in the
Participants List appeared. By default, CU-SeeMefillsup all available video window
frames with video images. To change this, see“ Closing All Video Windows’ on page
2-15. Continue reading to learn how to control which people appear on your screen.

There are two categories of participants. senders and lurkers. Senders are sending
video images and you can choose to see their images. Lurkers are not sending video
images. Perhaps they don’'t have cameras, or maybe they are choosing not to be seen.
Whatever the reason, you will not receive avideo image from alurker. However, if
you are sending video, both senders and lurkers can receive your image.

L ook at the ParticipantsList in Figure 2-17. Thislist contains both sendersand lurkers.

Senders have

cameras

Lurkers do not

have cameras

= =Y
Phil e [ =) 1
Tom = Ed:' ﬁ
Heidi = Eq:I ﬁ
Bt NP
Guillaume En o =)
K.atrina o E])
Elviz =) ﬁ
Jacques =)
N [ =

Figure 2-17. Participants List with senders and lurkers

To learn more about the Participants List and the information it presents, see
“Participants List” on page 4-12.

Swapping Video Images

If you want to see asender who isnot currently displayed on your screen, you can click
on a participant’s name to select it, and then drag it to a video window frame. Thisis
called drag-and-drop. The new participant’ simage will replace the previousimagein
that video window frame.
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Closing All Video Windows

If you don’t want all the video windowsfilled with images, or if you want more control
over who you see on your screen, you can close al the video windows and then select
only those participants you want to view. Note that this does not disconnect you from
the conference; it only closes the video windows. Y ou are still connected and others

can still seeyou.

To close all video windows:

1. Click the Video button on the toolbar. This displaysalist of all the participants
who are sending video images.

2. Point to Close All, then click.

3. All the video images disappear.

Showing All Video Windows

To fill up dl the video window frames again, follow these steps.

To show all video windows:

1. Click the Video button on the toolbar. This displays alist of all the participants
who are sending video images.

2. Point to Show All, then click.
3. All the video window frames will fill up with available video images.

To select individual video images, read the following section, “ Seeing a Participant”.
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Seeing Other People

Seeing a Participant

Y ou can choose which video images you want to see displayed on your screen.

To see a participant:

1. Click the Video button on the toolbar. This displaysalist of al the participants
who are sending video images.

2. Point to the name of the participant you want to select, then click.
3. Thevideo imageis now displayed in one of the open video window frames.
4. You can repeat this process to see video images from other participants.

Y ou can continue thisuntil al the video window framesarefull, or you can stop at any
time. You do not need to fill al the video windows. In fact, having fewer open video
windows will increase the performance of your computer during the videoconference.

Remember that the number of video images you can display depends on the type of
network connection you have. To learn more about displaying video windows, see
“Video Windows’ on page 4-19.

Being Seen

Just as you can choose to see other people in the Participants List, other participants
can also choose to see you if you are sending video. Whenever you join a conference
or connect with someone, your video image will be displayed in the local video
window. (If it isn't, make sure your camerais properly connected to your computer
and that it is turned on. Refer to the camera manufacturer’ sinstructions on installing
your camera, if necessary.) If you have acamera connected to your computer, you are
a sender. However, you can choose to become a lurker, which prevents others from
seeing your video picture.

To switch between being a sender and a lurker:
(Windows)

1. Make surethat your local video image is displayed in one of the video window
frames. If it isnot currently displayed, see” To see aparticipant:” on page 2-16 to
learn how to display your video window.

2. Using theright mouse button (right-click), click on your video image. A shortcut
menu appears. If you see a next to Send Video, then you are a sender.
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3. Click Send Video to become alurker. The O disappears. Y ou have stopped
sending your video image to other participants

4. If youclick Send Video again, you become a sender. Y ou have now turned your
video on and other participants can choose to see your video picture.

(Mac 0S)

1. Makesurethat your local video image is displayed in one of the video window
frames. If it isnot currently displayed, see” To see aparticipant:” on page 2-16 to
learn how to display your video window.

2. Hold downthe CONTROL key asyou click onyour video window (CTRL-click).
A menu appears. If you seea* next to Send Video, then you are a sender.

3. Click Send Video to become alurker. The s disappears. Y ou have stopped
sending your video image to other participants

4. If youclick Send Video again, you become a sender. Y ou have now turned your
video on and other participants can choose to see your video picture.

Note that if you do not have a camera attached to your computer, you are always a
lurker. Some group conferences limit the number of lurkers that can be connected at
any given time. If that number has been reached and you switch from being a sender
to being alurker, then you may be disconnected from that conference. If this happens,
call the conference again.
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Chatting with Others

Chatting with Others

Now that you are seeing some of the other people in the Conference Room, you may
wish to exchange messages with them. One way to do thisisto send typed messages
to other people using Chat. Chat enables you to communicate, even if you don’'t have
amicrophone or if your network connection istoo limited to carry audio.

Chat Window

Chat messages appear in the Chat window, as shown in Figure 2-18.

syzypgy: hello everyone

DawidD: Hey, check out the latest at http:/ fwva. cuseeme coml
Willy: |zn't CU-Seete awesomel

syzygy: let me launch that right now from my chat window
Woodinator: | will too.

PublicChat | ¢ B &
Type your

message here T[T HI Friends!

Figure 2-18. The Chat window allows you to exchange typed messages

To use the Chat window:

1. Typeamessagein the lower pane of the Chat window.

2. PressENTER.

3. Your message how appearsin the upper pane of the Chat window.

Other participants will see your message and you will see the messagesthat others are
typing. Y ou can follow Chat conversationsin the upper pane of the window. Messages
appear in the order in which they are received.

To learn more, see “Chat Window” on page 4-26.
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Sending and Receiving Audio

In addition to seeing others, and exchanging Chat messages, you can also talk to other
participants and hear their voices. To hear other participants, you must have speakers
or headphones connected to your computer. To talk to other participants, you must
have a microphone connected to your computer.

Tolearn about the audio features of CU-SeeMe, see“Audio Modes’ on page 4-34 and
“Audio Controls and Indicators’ on page 4-36.
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Disconnecting From the Conference

Disconnecting From the Conference

®!

When you are ready to leave the White Pine Cafe, you can disconnect from the
conference in one of 2 ways.

To disconnect from a conference:

On the Conference menu, click Hang Up.
-or-

Click the Hang Up button on the toolbar.

Thiswill disconnect you from the White Pine Cafe. Y our videoconference session is
over. The Conference Room window will close automatically and the Phone Book
window will appear. Actually, it never disappeared; it remained on your desktop
behind the Conference Room window. Y ou can exit the application or use the Phone
Book to connect to other conferences. To learn more about using the Phone Book, see
Chapter 3.

To exit the application:

Do one of the following:

* (Windows) Choose Exit from the File menu in the Phone Book.

* (Mac OS) Choose Quit from the File menu.
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White Pine

Chapter 3
Using the Phone Book

The CU-SeeMe interface has two main windows: the Phone Book and the
Conference Room. This chapter explains how to use the Phone Book and its
components. See Chapter 4 for information on how to use the Conference Room.

Think of the Phone Book as your personal directory whereyou can list your friends,
family members, business contacts, or anyone you might want to call. Y ou can also
think of the Phone Book as a speed dial list. Y ou can make videoconference calls
directly from the Phone Book.

The Phone Book includes a collection of Contact Cards. Y ou can have a Contact
Card for each person or place that you call. Some cards are included in CU-SeeMe
to get you started and you can add or delete cards at any time.

Y ou can aso use the Phone Book to set up a Personal Profile for yourself. This
profile defines information about you and your connections, such as your
CU-SeeMe user name and communication settings. When you set up your Personal
Profile, you create a Profile Contact Card about yourself. This card stores
information which you can share with others.
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Components of the Phone Book

Components of the Phone Book

The components of the Phone Book are shown in Figure 3-1.

Menu§ ———

Toolbar

Contact Group

List of
Contact Cards

Selected
Contact Card

[B8l Phone Book - CU-SeeMe
e Edit Wiew LCal Wwindow Help

— 8
|l specdDidl

@ 5 o

Mew Card Manual Dial  ‘who's Online  Call Options Test Setup

-

Jen =

Contact Cards:

Chia Metwark

Connecting Paint HD
Connecting Point 50
Coarnell University

Selected Card:
White Pine Software Inc.
542 Arerst Street
Nazhus, NH 03063
USA
White Pine

Click hers to call

CSELT

CSELTIT)

Dalhousie | niversity

EDEM

Farago Audvertizsing =l

eMall:  infof@wpine .com
Home Page: htte i v ineasom

52 o

Status Bar ————Ciick the Speed Dial button ta call wWhits Pine Cafe

Figure 3-1. The Phone Book has several components

The Phone Book components are explained in the following sections, as shown in

Table 3-1.

Table 3-1. Where to find informatio

n on Phone Book components

To find out information about... Go to...
Phone Book Menus page 3-3
Phone Book Toolbar page 3-11
Contact Cards page 3-12
Contact Groups page 3-13
Status Bar page 3-15
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Phone Book Menus

Y ou can access CU-SeeM e commands from the Phone Book menus. Y ou activate a
menu by clicking on it. When you do, the menu’s commands are displayed. If a
command is not available to you, it appears dimmed. Commands in the menu that are
followed by ellipsis(...) need more information from you before they execute. These
commands display dialog boxes that ask you for more information. Commandsin the
menu that are followed by atriangle indicate that a submenu is available. Pause your
mouse pointer over that command and a submenu will appear.

Explanations and descriptions of the Phone Book commands for both Windows and
Mac OS start on page 3-4.

The CU-SeeMe Menu for Mac OS

There are some differences in the appearance of CU-SeeMe, depending on whether it
is running on the Windows or Mac OS operating system. One notable differenceis
that, in Windows, the menu islocated at the top of the Phone Book or Conference
Room window. Figure 3-1 shows the menu at the top of the Phone Book in Windows.
In the Mac OS, the menu bar is not attached to the Phone Book or to the Conference
Room window. Instead, it is always found at the top of your screen.

The CU-SeeMe menu bar for Mac OSis shown in Figure 3-2.

File Edit Call Conference Window Help

Figure 3-2. The CU-SeeMe menu bar for Mac OS is always at the top of your screen

This menu bar displays all of the CU-SeeMe menu items. Y ou can access CU-SeeMe
commands from these menu items. Some commands may be available only when you
are using the Phone Book, and other commands may be available only when you are
in the Conference Room. Unavailable commands appear dimmed. (The Help menu for
Mac OS 8 appears on the menu bar, as shown above. In earlier Mac OS versions, the
Help menu appears as a question mark 3J at the top right corner of the screen.)

Commands specific to Windows or Mac OS in the following tables are noted with
parentheses (). Only active Phone Book commands are included, so Mac OS
commandsthat are unavailable from the Phone Book are not explained in this chapter.
Refer to Chapter 4, Using the Conference Room, for a description of commands
available from the Conference Room window.
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Phone Book Menus

File Menu

The commands under the File menu are described in Table 3-2.

Table 3-2. The commands under the File menu in the Phone Book

File Command

Description

New Contact Card Assistant...

Opens the Contact Card Assistant, a
step-by-step guide to creating a new
Contact Card.

This command is also available by clicking
the New Card button on the Phone Book
Toolbar.

New Contact Card

Creates a new Contact Card, which can be
edited later.

Close (Mac OS)

Disconnects you from your current
connection and closes the Conference
Room window. The Phone Book window
remains on your screen. This command is
only available when you are connected to a
conference.

Import... Imports data and creates new Contact
Cards.

Export > Saves the selected Contact Card to a file.

Send Mail... Sends e-mail to the address on the selected

Contact Card.

(Windows - Note that your e-mail program
must be configured to use MAPI. See your
e-mail vendor’'s documentation to learn if it
is MAPI-compliant.)

(Mac OS - CU-SeeMe will use your default
e-mail program. To change your e-mail
program, click the Call Options button, and
select Phone Book. Click the Launch
Internet Config button. Click on Helpers,
select mailto, click the Change button, then
click Choose Helper to choose the e-mail
program you want to use. Click OK when
done.)

Page Setup (Mac OS)

Displays the Page Setup dialog box where
you can change paper options such as size,
layout and orientation.
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Table 3-2. The commands under the File menu in the Phone Book

File Command

Description

Print Setup...

Displays the Print Setup dialog box where
you can change the printer and print
options.

Print Preview (Windows only)

Displays the Print Preview dialog box,
where you choose whether to preview a
selected Contact Card or a group of Contact
Cards.

Print...

Displays the Print dialog box, where you
choose whether to print a selected Contact
Card or a group of Contact Cards.

1: most recent connection
2: previous connection

Lists the most recent connections you have
made. Click on a name in this list to
reconnect.

Exit (Windows)
Quit (Mac OS)

Exits the CU-SeeMe program.

Edit Menu

The commands under the Edit menu are described in Table 3-3.

Table 3-3. The commands under the Edit menu in the Phone Book

Edit Command Description

Undo Reverses the last text edit, such as
renaming an entry in the list of Contact
Cards.

Cut Removes the selected Contact Card from
your Phone Book and puts it on the
Clipboard.

Copy Copies the selected Contact Card to the
Clipboard.

Paste Pastes the current content of the Clipboard.

Delete Deletes the selected Contact Card.

Select All Selects all the Contact Cards in the current
Contact Group.
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Phone Book Menus

Table 3-3. The commands under the Edit menu in the Phone Book

Edit Command

Description

Edit Groups... (Mac OS)

Displays the Edit Groups dialog box where
you can add and delete Contact Groups
and modify their attributes.

Find

Displays the Find a Card dialog box where
you can initiate a search of your Contact
Cards.

Find Next

Finds the next Contact Card, based on the
search information you entered in the Find a
Card dialog box.

Call Options...

Displays the Call Options dialog box where
you can change settings for Profiles,
Listener, Security, and Phone Book options.

This command is also available by clicking
the Call Options button on the Phone Book
Toolbar.

Contact Card Properties...

Displays the Contact Card Editor dialog box
where you can modify the properties of the
selected Contact Card, including network
settings used when calling the person or
place on the selected card.

Current Profile...(Mac OS)

Displays the Personal Profile Editor dialog
box, where you can modify your Personal
Profiles.

Test Setup...

Displays the Test Setup dialog box where
you can test and modify your video,
microphone, speaker, and network settings.

This command is also available by clicking
the Test Setup button on the Phone Book
Toolbar, or from the Quick Start and Tips
window.
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View Menu (Windows)

Note: CU-SeeMe for Mac OS has no View menu.

The commands under the View menu are described in Table 3-4.

Table 3-4. The commands under the View menu in the Phone Book

View Command

Description

Status Bar

Turns on and off the option of viewing the
Status Bar at the bottom of the Phone Book.
A O indicates that the option is turned on.

Contact Card

Turns on and off the option of viewing
Contact Cards in the Phone Book. A [
indicates that the option is turned on.

Groups > Displays the list of Contact Groups and the
Edit Groups command. The current group is
indicated with a 0.

Who's Online... Displays the a list of users who are currently

online using CU-SeeMe (and are registered
with Fourl1 directory service).

This command is also available by clicking
the Who's Online button on the Phone
Book Toolbar.

Directory Services...

Opens a Web browser and connects to the
Fourl1 directory service Web page.

Call Menu

The commands under the Call menu are described in Table 3-5.

Table 3-5. The commands under the Call menu in the Phone Book

Call Command

Description

Speed Dial current listing

Calls the person or place on the selected
Calling Card.

This command is also available by clicking
the Speed Dial button on the Phone Book
Toolbar.
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Phone Book Menus

Table 3-5. The commands under the Call menu in the Phone Book

Call Command

Description

Favorites > Displays a list of Contact Cards in your
Favorites Contact Group. You can select a
card from this group and call the person or
place listed on the card.

Manual Dial... Displays the Dial dialog box where you can

type an IP address to make a call.

This command is also available by clicking
the Manual Dial button on the Phone Book
Toolbar.

Create Multicast Conference...
(Windows)

Opens the Multicast Assistant, a
step-by-step guide to creating a multicast
conference.

Who’s Online... (Mac OS)

Displays the a list of users who are currently
online using CU-SeeMe (and are registered
with Fourl1 directory service).

This command is also available by clicking
the Who's Online button on the Phone
Book Toolbar.

Directory Services... (Mac OS)

Opens a Web browser and connects to the
Fourll directory service Web page.
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Window Menu

The commands under the Window menu are described in Table 3-6.

Table 3-6. The commands under the Window menu in the Phone Book

Window Command

Description

Quick Start & Tips... (Mac OS)

Displays the Quick Start & Tips window.

Phone Book (Mac OS)

Displays the Phone Book window. This
command appears dimmed because the
Phone Book is currently displayed.

Conference Room

Brings the Conference Room window to the
front. This command appears dimmed if you
are not currently connected to a conference.

Whiteboard (Windows)

Brings the WhitePineBoard window to the
front. This command appears dimmed if you
are not currently in a WhitePineBoard
session. (See the WPBoard.pdf file for more
information.)

Chapter 3. Using the Phone Book
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Phone Book Menus

Help Menu

The commands under the Help menu are described in Table 3-7.

Table 3-7. The commands under the Help menu in the Phone Book

Help Command

Description

CU-SeeMe Help Topics

Opens the CU-SeeMe Help file and displays
the contents of the Help file.

Search for Help On (Windows)

Opens the CU-SeeMe Help file and displays
the Find page.

CU-SeeMe Events

Opens a Web browser and displays a Web
page showing a schedule of events to which
you can connect using CU-SeeMe.

Technical Support

Opens a Web browser and displays the
White Pine Software Technical Support Web

page.

Registration

Opens a Web browser and displays the
White Pine Software Product Registration
Web page, allowing you to register your
copy of CU-SeeMe online.

Quick Start & Tips

Displays the Quick Start and Tips window.

About CU-SeeMe... (Windows)

Displays information about your version of
CU-SeeMe.

In the Mac OS, this command is found
under the Apple g§ menu.
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Phone Book Toolbar

The Phone Book toolbar has buttonsthat provide shortcutsto many commands. Asyou
move your mouse pointer over each button, the selected button becomes highlighted.
Y ou can then click the button to select it.

When you pause your mouse pointer on each button, atool tip appears. No clicking is

necessary. Thetool tip gives you information about the function of each button.

The Phone Book toolbar buttons are explained in Table 3-8.

Table 3-8. The Phone Book toolbar buttons

Toolbar Button

Description

5

Speed Dial

Calls the person or place on the selected
Calling Card.

£y

Opens the Contact Card Assistant, a
step-by-step guide to creating a new
Contact Card.

New Card
Displays the Dial dialog box where you can
B type an IP address to make a call.
Manual Dial
- Displays a list of users who are currently
E 2 online using CU-SeeMe.
Who'’s Online
—— Displays the Call Options dialog box where
ga. o you can change settings for Profiles,

Listener, Security, and Phone Book options.

Test Setup

Displays the Test Setup dialog box where
you can test and modify your video and
audio settings.

To learn more testing your setup, see “Test
Your Setup” on page 5-12.

Chapter 3. Using the Phone Book
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Contact Cards

Contact Cards

A Contact Card islike abusiness card or acard in arotary file. It isa convenient way
to present and store information about a person or place, including contact
information. The list of Contact Cards contains the names of people and places you
might want to call. Some cards are already in thislist and you can add and del ete cards
at any time.

Selected Card

Y ou can display a Contact Card for each entry in your Phone Book. The Contact Card
currently displayed in your Phone Book corresponds to the highlighted namein the
Contact Card list. When you click on another Contact Card nameinthelist, adifferent
Contact Card is displayed.

A sample Contact Card is shown in Figure 3-3.

White Pine Software Inc.

542 Amherst Street
Mashua, NH 03063
USA

White Pine
Click here to cali

eMail.  info@rwpine. com

Home Page:  httpo e wpine. corm

X T

Figure 3-3. A Contact Card allows you to store information and make connections

To learn how to create a Contact Card, see “Adding Entries in the Phone Book” on
page 3-20. To learn how to make a call using a Contact Card, see“Making Callsfrom
the Phone Book” on page 3-16.

When you create a Personal Profile (see “Creating a Personal Profile’ on page 3-25),
you also create a Profile Contact Card about yourself. Y ou can share your Profile
Contact Card with others and receive cards from other people. Thisis similar to
exchanging business cards, except that you distribute a card file electronically, rather
than handling paper cards. To learn more, see “ Getting Information About a
Participant” on page 4-39.
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Contact Groups

Y ou can organize your collection of Contact Cardsinto categories, or Contact Groups.
For example, you might want a group containing all of your business contacts and
another group containing all of your social contacts. Or if you share you computer with
other people, each person might want his’her own Contact Group. Y ou can have the
same name listed in more than one Contact Group. For example, you might want a
co-worker listed in your Business Contact Group and also in your Social Contact
Group.

Broadcast
MaSa Televigion
People

Figure 3-4. The list of Contact Groups is displayed

To select Contact Groups:

1. Click the arrow as shown in Figure 3-4.
2. Poaint to the Contact Group you want to select, then click.

(Windows)

sdnoJo 1981U0)

In Windows, you can also select Contact Groups from the View menu, as follows:

1. OntheView menu, point to Groups.
2. Point to the Contact Group you want to select, then click.

The group you selected is now displayed in your Contact Card list and thefirst card in
thelist is shown as the selected card. If you select the All Contact Group, you will see
all the Contact Cardsin your Phone Book.
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Contact Groups

3-14

To edit Contact Groups:
(Windows)
1. OntheView menu, point to Groups.

2. Pointto Edit Groups, then click. The Edit Groupswindow isdisplayed, asshown
in Figure 3-5.

(Mac OS)
1. Onthe Edit menu, point to Edit Groups, then click.

2. The Edit Groups window is displayed, as shown in Figure 3-5.

Edit Groups

Selected Group

Business

Conferences Help |

Click to change the name of the selected Personnal

Contact Group and to change the
sharing and Parental Control properties

Click to delete
the selected |

Contact Group

Click to add a New Contact ——————  4dd.. | Delete | Propeties. . |
Card and to assign sharing
and Parental Control properties

Figure 3-5. The Edit Groups window lets you add, delete, and modify Contact Groups

If you delete a Contact Group that contains Contact Cards, these cards will till be
available from the All group.

Tolearn how to move a Contact Card from one Contact Group to another, see“ Editing
a Contact Card” on page 3-23. To learn about Parental Control, see “Using Parental
Control” on page 3-39.
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Status Bar

The Status Bar, located at the bottom of the Phone Book, providestipsand information
about your current status. When you click and hold on atoolbar button (Windows), or
move your mouse pointer over atoolbar button (Mac OS), the Status Bar presents
information about that button. Also, when you pause your mouse pointer on a menu
command, the Status Bar presents information about that command.

When you are not connected to a conference, the Status Bar displays information
telling you which Phone Book entry you have selected. Once you have made a
connection, the Phone Book Status Bar tells you how long you have been connected.
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Making Calls from the Phone Book

Making Calls from the Phone Book

Y ou can make videoconference calls directly from the Phone Book. To make a call,
you can usethe Speed Dial function, you can manually dial anumber, or you can select
aperson to call from alist of who's online. These methods are explained in the
following sections.

Speed Dialing
The Speed Dial allowsyou to call aperson or placelisted onthe selected Contact Card.

To call using Speed Dial:
1. Click on aContact Card listed in the Phone Book.

2. Click the Speed Dial button on the Phone Book toolbar. This begins your
B connection to the person or place listed on the selected Contact Card.

3. Whileyour computer is establishing the connection, you will see the window
shown in Figure 3-6. If you have a camera and are sending video, you will see
your picture in thiswindow. Y ou will also see the Contact Card of the person or
place to which you are connecting.

Connection
] s B M ¢

Internet

Connecting to 199.94.217.135...

wnl® Ane Bofkare no.
i devarinr
Py

=

Witn Fina

e wigepncon
[y » sue

L] L]

Figure 3-6. Your computer is establishing a connection
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(9/5) indicates that there
are currently 9 senders

and 5 lurkers in this
conference.

ACV indicates that
this conference
supports Audio,
Chat, and Video.

If the conference
requires an ID, you
will need to enter
it here.

4. Oncethe connection is made, this window will change to display alist of
conferences you can join (see Figure 3-7). Select a conference, then click Join.

Connection

m B h
ALY [10/8) Generic Medium B andwidth
ALY [10/8) Generic Medium B andwidth
ALY [4/3) Modem Users conference

;|
2
3
4 AV [0/2) Small High B andwidth

If the conference is

Conference ID: [0 Password: | —————— password-protected, you

will need to enter a

Jan | Corel | password before joining.

Figure 3-7. Choose a conference to join

5. After you select a conference, the window will display a Message of the Day as
shown in Figure 3-8. This message is unique to each conference. Read this
message to learn about any special rules or conditions relating to this conference.

Connection

MeetingPaint [tm] 3.0.1 Alpha [Dec 11997 16:44:23) -
‘welcome to The “White Pine Cafe MeetingPoint server at 199.94.217.135.

For FAQ's go to hitp://support. cuseeme. com/
THIS SITE 15 G-RATED!

Clothing, including shirts, must be waorn at all imes when displaying video on this
MeetingPoint server.

You are allowed B0 minutes of connect time, after which vou will be disconnected.

Jid]

Figure 3-8. Message of the Day

6. Click Go! to enter the conference.

In addition to these steps, there are other ways you can call using Speed Dial. These
are described next.
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Making Calls from the Phone Book

Other ways to call using Speed Dial:

O Double-click on aContact Card in thelist.
-or-

0 Click onthe phrase Click hereto call on the selected Contact Card.
-or-

(Windows)

O Using the right mouse button (right-click), select a Contact Card in the list. A
shortcut menu appears. Click Speed Dial.

(Mac OS)

O Hold down the CONTROL key as you click on a Contact Card in the list
(CTRL-click). A shortcut menu appears. Click Speed Dial.

Manual Dialing

At times you might want to dial a person or place that is not already listed in your
Phone Book. To do this, you can manually dial a number by typing the Internet
Protocol (1P) address or the host name of the person or place you want to call.

Note: For the connection to work, the person you are dialing must aready be online
with CU-SeeMe or the person’s Listener must be enabled and set to accept calls. (To
learn more, see “Using the Listener” on page 3-30.) If you want to connect to a
conference, that conference must be running when you didl it.

To call using Manual Dial:
1. Click the Manual Dial button on the Phone Book toolbar.

2. TheManual Dia dialog box appears. Type the |P address or the host name of the
person or place you want to call.

Optional: Click the Conference tab. Type the Conference ID and Password (if a
Conference ID or password are required) for the conference server to which you
want to connect. If you want to connect directly to a specific conference and
bypass the dialog box that lists all available Conference Rooms, you heed to
specify the Conference | D number preceded by 0 (zero). For example, if you want
to connect to Conference 2, specify the Conference ID number as 02.
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Optional: Click the Network tab to modify transmission and reception rates and
enforce minimum reception and transmission rates for your manual call.

3. Click Manual Dial. This begins your connection.

Calling Who's Online

CU-SeeMe can tell you who is currently online using CU-SeeMe. Y ou can select one
of these namesto call.

To find out who’s online:
1. Click the Who's Online button on the Phone Book toolbar.

2. The Whao's Online window appears listing users who are currently online using
CU-SeeMe. Click on anamein the Who's Online list.

3. Click the Speed Dial button on the Who's Online toolbar. This begins your
connection.

4. Youcanalso click the Web Sear ch button to open aWeb browser and connect to
the Four11 directory service Web page.

The names appearing in the Who's Online list are people who are currently online
using CU-SeeMe and have registered with Four11 directory service. To learn more
about registering with Four11 directory service, see “Registering With an Online
Directory Service” on page 5-24.
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Adding Entries in the Phone Book

Adding Entries in the Phone Book

Y ou can add new Contact Cardsto the Phone Book. The easiest way to do thisisusing
the Contact Card Assistant. The Contact Card Assistant guides you through the steps
needed to create a new Contact Card.

To use the Contact Card Assistant:
1. Click the New Card button on the Phone Book toolbar.

2. The New Contact Card Assistant is displayed, as shown in Figure 3-9.

Welcome to the Contact Card Assistant!

There are 3 steps to create a Contact Card,
‘You are now on step one.

*r'ou will create a Contact Card which will appear in wour Phone Book. Thiz card will show information
about the person or place you wish to contact, and will enable you ta make quick and easy connections.

@ Enter calling information
IEI Enter data on a Contact Card

IEI Add a picture to the Contact Card

Eirrsty | Cancel | Help |

Figure 3-9. The New Contact Card Assistant makes it easy to create new Contact Cards

Follow the stepsin the New Contact Card Assistant. It guides you through the creation
of a Contact Card and adds a hew entry to the Contact Card list.

Y ou can also add anew entry in the Phone Book without using the Assistant. Thisis
useful if you want to add an entry but don’t have much information to complete a
Contact Card.

To add a simple Phone Book entry:
(Windows)
1. OntheFile menu, click New Contact Card.

2. A new Contact Card is created with the name Untitled. To rename this card, type
the new name now. This new name will appear in the Contact Card List in the
Phone Book.
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(Mac 0S)

1. OntheFile menu, click New Contact Card.
2. A new Contact Card is created with the name Untitled.

3. Onthe Edit menu, click Contact Card Properties. The Contact Card Editor
displays. Select the General tab.

4. Typethe new Nickname and click OK.

The name you typed will be added to your Contact Card List and aNew Contact Card
will be created. This card will have minimal information, and you can edit this card at
any time to add or change information. Y ou can also change the name of the Contact
Card asit appearsin the Contact Card list.

Y ou can a'so import fileswhich contain data that can be converted into Contact Cards.

To import data into your Phone Book:
1. OntheFilemenu, click Import.

2. The Open diaog box is displayed, as shown in Figure 3-10.

Open
Lookjn: | 4 CU-SeeMe - ok

| Idirgve
|__Ifarms

| 15onaComm
| Izounds

@ default.cu

@ wpcafe.cu

Files of bpe: ICu-SeeMefiIes [7.cu) b Cancel |

Mickname files [Mickname.ini)
CSY files [*cev)
T et files [* tat]

Figure 3-10. You can import files and convert the data to Contact Cards

3. You canimport several types of files. Click the arrow (as shown in Figure 3-10)
to display alist of file types that you can import.
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Adding Entries in the Phone Book

CU-SeeMefiles (*.cu) and CSV files (*.csv) can beimported directly as contact cards
into the currently selected Contact Group. Nickname files (Nickname.ini) contain the
data from the Phone Book in earlier versions of CU-SeeMe. If you have an earlier
version of CU-SeeMe, you can import the Nickname filesto bring your old Phone
Book entries into your new Phone Book. If you select Text files (*.txt), the Phone
Book Import Assistant is displayed. Thisis a step-by-step guide to creating new
Contact Cards using existing text files.
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Editing a Contact Card

Once you have created a Contact Card, you can edit it to add or change information,
or you can delete the card to remove it from the Phone Book

To edit a Contact Card:
1. Select the entry in the Contact Card list.

2. Onthe Edit menu, click Contact Card Properties. The Contact Card Editor
appears, as shown in Figure 3-11.

Contact Card Editor [ %]
Card Perzonal Info I Card Business Info I Card Layout I
General | Connection I Network
~ Phone Book
g Mickname : | RN aTa=0=

V' Add entry in Favorites menu

— Group

@ Select the groups you want this card to belong to.

[ 1Broadcast
[w]Buziness
[w]Conferences
[ 1Personnal

Group Editar... |
QK I Cancel | Help |

Figure 3-11. The Contact Card Editor lets you modify Contact Cards

3. Select atab to choose what aspect of the card you want to edit. For example, the
General tab lets you edit the Nickname text field, which is the name that appears
in the Contact Card list.

4. When you have completed all your edits to the Contact Card, click OK.

To delete a Contact Card:
1. Select the entry in the Contact Card list.

2.  Onthe Edit menu, click Delete.

3. Youare asked if you are sure you want to delete this card.
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Editing a Contact Card

3-24

O (Windows) Click Yesto delete the card or No to cancel the delete process.

O (Mac OS) Click Delete to delete the card or Cancel to cancel the delete process.
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Creating a Personal Profile

A Personal Profileidentifiesyou to other people on the network.Y our Personal Profile
includes your CU-SeeMe name, which is your on-screen name that others see when
you are conferencing. When you create a Personal Profile, you also create a Profile
Contact Card about yourself. Y our Profile Contact Card islike abusiness card that you
can exchangewith otherselectronically. To learn how to exchange Contact Cardswith
others, see“ Getting Information About a Participant” on page 4-39.

If you chooseto videoconference on public conferences, your Profile Contact Card can
be seen and saved by anyone with CU-SeeMe; therefore, you should be careful what
information you choose to display on your Profile Contact Card. For example, if you
do not want strangers to have your phone number, then you should not list it on your
Contact Card.

Y our Personal Profile also containsinformation about Parental Control options, and
your computer setup. To learn more about Parental Control, see “Using Parental
Control” on page 3-39.

Y ou can create one or more Personal Profiles. For example, you might want one
profile for personal use and onefor home use, or you might want different profilesfor
different members of your family.

To create a Personal Profile:

1. Besurethat you are not connected to aconference when you create your Personal
Profile. The Phone Book window should be your active window. If it is not, then
click on the Phone Book window to make it the active window.

2. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then
click.
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Creating a Personal Profile

3. TheCU-SeeMe Call Optionsdialog box appears (with the Profilestab displayed),
as shown in Figure 3-12.

CU-SeeMe Call Options [ %]

Frafiles | Listenerl Securityl Phone Bookl

— Perzonal profile:

‘William Finetres
NS, A 03003

Civok frora 0o ol

eMall; Dhetee@biestom
Home Page: ¥MMIMDIk oM

] ] | Click to create a new profile.

Click in rghe chef;lr:kfbox CUSasMe User T
to use this profile for s [ Click to edit the selected profie.
your next videoconference. v Tl
Click on a profile name — Click to create a profile which is
to select it. _ Duplicate | a duplicate of the selected one.

You can then edit this new
Select this to be prompted Delets_| profile.
to choose a proﬁle =¥ Prompt for a profile at startup
each time you start )
CU-SeeMe. Delete the selected profile.

QK I Cancel | Help |

Figure 3-12. You can create and edit your Personal Profile

4, Click New.

5. The Personal Profile Assistant is displayed, as shown in Figure 3-13.

Wel to the P | Profile A

Follow these steps to create a Perzonal Profile which defines pour
CU-SeeMe user name, your communication settings, and how you want
ta share information with other CU-Seete users.

*r'ou will create a Personal Profile which will define how you will appear in a Yideo Conference, what
are your basic communication setttings, if you want to register to a Directary Service, and what
information you want to publish to remote contacts.

Define your CU-5eeMe name
Select pour communication settings
Publish pour connection status in a Directory Service

Enter information on your Profile Contact Card

EIRENENENE

Add a picture to your Profile Contact Card

< Back

Cancel | Help |

Figure 3-13. The Personal Profile Assistant makes it easy to create a Personal Profile
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Follow the steps in the Personal Profile Assistant. It guides you through the creation
of aPersonal Profile including a Profile Contact Card. Y ou can repesat these steps to
add additional profiles.
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Editing a Personal Profile

Editing a Personal Profile

Y ou can edit your profilesif you want to add or change any information. For example,
you might want to change your CU-SeeMe name, which is your on-screen name that
others see when you are conferencing.

To edit a Personal Profile:

e L
o+ 0
oo
oo

2.

3.

4,

5.

6.

Click the Call Options button on the Phone Book toolbar. Point to Profiles, then
click.

The CU-SeeMe Call Options dialog box appears (with the Profilestab displayed),
as shown in Figure 3-12.

Click Edit.

The Personal Profile Editor appears, as shown in Figure 3-14.

Personal Profile Editor [ %]
General | Security I Hardware I
Card Personal Info | Card Business Info I Card Layout

— Perzonal profile infarmation

Full name : IWiIIiam Finetree Attach Sound... |

E-mail address Ipinetree@forest.com

Home page : Iwww.wpine.com

Pastal address : [Washua, MH 03053

Phone : I

Eax:l

 Picture

Take a gnapshot |

(et Bicture Eranm Elipbeard |

Get Picture From Dizk... |

QK I Cancel | Help |

Figure 3-14. The Personal Profile Editor lets you modify your profile

Select atab to choose what aspect of the Personal Profile you want to edit. For
example, the General tab lets you edit your CU-SeeMe name, which is the user
name that appears when you conference with others.

When you have completed all your edits to the Personal Profile, click OK.
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To delete a Personal Profile:

1

w

[

Click the Call Options button on the Phone Book toolbar. Point to Profiles, then
click.

The CU-SeeMe Call Optionsdialog box appears (with the Profilestab displayed),
as shown in Figure 3-12

Click Delete.
You are asked if you are sure you want to delete this profile.
(Windows) Click Yesto delete the profile or No to cancel the delete process.

(Mac OS) Click Delete to delete the profile or Cancel to cancel the delete
process.
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Using the Listener

Using the Listener

TheListener isaprogram that letsyou know if someoneistrying to call your computer
for avideoconference, even when CU-SeeMe is hot running or when you are aready
connected to a conference or another call. It will listen for incoming calls and it will
notify you. Y ou can accept, ignore, or refuse the call.

The Listener is automatically turned on when CU-SeeMeis running. This means that
if you arein avideoconference and someone el se calls you, you will be notified of the
call so you can accept it or not. If you accept it, you will be disconnected from your
current videoconference because you cannot be connected to two conferences
simultaneously. Y ou will then be connected to the new, incoming call.

Enabling the Listener

If youwant to havethe Listener running even when CU-SeeMeisnot running, you will
need to enable the Listener to run as a start-up program. This means that the Listener
will start automatically when Windows or Mac OS starts on your computer. In this
scenario, you will be notified of an incoming call even when CU-SeeMe s not
running. Y ou can accept or deny the call. If you accept the call, the Listener
automatically starts CU-SeeMe so you can begin conferencing with the caller.

To enable the Listener:

1. Click theCall Options button on the Phone Book toolbar. Point to Listener, then
click.
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2. TheCU-SeeMeCall Optionsdialog box appears (with the Listener tab displayed),
as shown in Figure 3-15.

CU-SeeMe Call Options [ %]

Profiles  Listener | Securityl Fhone Bookl

Listener Enabling
lets you turn the s this aotion e i remee "

. Py € thiz oplion IF you want [0 De able o recenve callz even il
Listener on or Off g ClJ-5eetde iz not running.

™ Bun listener at startup

— Ligtener Enabling

Listener Active Filters ——— —Listener sctive Fiter
let you block calls
from specific users

2]
5

Mew... | Eroperties... [uplicate WElete |

Default Listener Settings
|EtS yOU Change the == Default Listener Setting:
way you are notified ; : -
of incoming Ca”S, define g Eg:it\}:?“;j:[f;ult zettings for incoming calls that do not match
how the Listener

responds to calls you Default Settings... |

don't answer, and
customize a ring

QK | Cancel | Help |

Figure 3-15. You can enable the Listener to notify you of incoming calls

3. Select the check box labeled Run listener at startup, as shown in Figure 3-16.

— Listener Enabling
by Usze thiz option if pou want to be able to receive calls even if %“CIE.tO stop running
. li Cl-Seetde iz not running. the 'Stener
Select this to have the temporarily.
Listener run every time ———— | Bun listener at startup Suzpend listening now ‘|—— C“Ck_ again to resume
you start your computer. [% running the Listener.

Figure 3-16. You can enable the Listener to run even when you are not running CU-SeeMe

4. The button next to this check box toggles between two modes. It says either
Suspend listening now or Resume listening now. If you decide that you want to
stop running the Listener temporarily, click Suspend listening now. When you
click it, the button changes to say Resumelistening now. The label on the button
tells you what will happen when you click the button. When you want to resume
using the Listener, click the button again. For now, the button should say Suspend
listening now.

5. Thenext timeyou restart your computer, the Listener will be enabled to run even
when CU-SeeMeisnot in use.
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Using the Listener

(Windows)

Y ou will seethe Listener icon [_"_l. in the Windows Taskbar, letting you know that the
Listener is running. To turn the Listener off, right-click on theicon in the Taskbar,
point to Disable Listening, then click. The icon changes ﬂ to indicate that the
Listener is turned off.

Changing Listener Default Settings

The Listener is set up to notify you of al incoming calls by displaying a Notification
dialog box, and ringing ten times. If you do not accept an incoming call within ten
rings, the call is automatically refused. Y ou can change these default settings.

To change the Listener default settings:

1. Click the Call Optionsbutton on the Phone Book toolbar. Point to Listener, then
click.

2. TheCU-SeeMeCall Optionsdialog box appears (with the Listener tab displayed),
as shown in Figure 3-15.

3. At the bottom of thisdialog box is a section called Default Listener Settings.
Click the Default Settings button to display the Listener Default Settings dialog
box, shown in Figure 3-17.
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4. Therearetwo sections of thistab that you can modify. Oneisasection called Get
my attention, which defines how you want to be notified of incoming calls, and
theother sectioniscalled Call r esponse, which defineshow you want the Listener
to respond if you don’t answer the incoming call. These are explained in the

following sections.

Get my attention lets you
select a notification
method for incoming calls

Listener Default Settings

Filter |label : IDefauIt Behavior ¥ | ctivate this filter

—Match

Match values :

1P &ddress Elfis Bl

Get my attention

Call response lets you
choose a response if
you don't answer an
incoming call

" Noring ¥ Open Matify Dialog
o i I Elash [active caption bz 7]
" Distinctive ring : none
Brawse,., | ’l .l
Call responze
' Riing forever

' lgnore this Call with no Message

' Refuse Call after I‘IDrings 'l with meszage.

QK I Cancel | Help |

Figure 3-17. You can modify the default settings of the Listener
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Using the Listener

3-34

Modifying the Notification Method

Using the Listener Default Settings dialog box, you can define how you want to be
notified of incoming calls. In the section of the Listener Default Settings dialog box
called Get my attention, you can select the sound you want to hear when you are
notified of acall. This section is shown in Figure 3-18.

You can select whether

you want the Listener to

ring when you are called.
Then select the ring sound.
Here a Distinctive ring ——
is selected.

— Get my attention
" Noring

™ Standard ring

— {+ Distinctive ring : none

Click the Browse button

ﬂﬂ- Open Motify Dialog

IT Flazh I.ﬁ.ctive caption bé 'I

L2

to select a ring from the

CU-SeeMe Sounds folder
or select any .wav sound.

I
Click to play (and stop)
the selected sound.

Select to open a dialog
box to notify you when
you are being called.
(Windows only)

Select to have a part of
your screen flash when
you are being called.
Use the drop-down list
to select which part of
your screen will flash.
(Windows only)

Figure 3-18. You can define how you want to be notified of incoming calls
Y ou can select one of the following ring options:

O Noring
0 Standardring
O Distinctivering

If you select Distinctive ring, you then need to click the Browse button to find a.wav
file on your hard disk. Y ou can browse to the CU-SeeMe folder (in Windows, usually
on the C: drive at C:\Program Files) then the sounds folder, and finally select
conflist.wav or any other .wav file.

Use the Play button to listen to the sound. This sound will replace the standard ring to
notify you of an incoming call.

(Windows)

« If the Open Notify Dialog check box is selected, you will also see adialog box
whenever you receive an incoming call. This dialog box makes it easy to
respond to the call.

« If theFlash check box is selected, aportion of your screen will flash to get your
attention and let you know that you are being called. If you select Flash, then
you can use the drop-down list to select which portion of the screen will flash.

CU-SeeMe User Guide



Modifying the Listener Response

Using the Listener Default Settingswindow, you can define how you want the Listener
torespond if you don’t answer theincoming call. In the section of the Listener Default
Settings dialog box called Call response (shown in Figure 3-19), you can select the
following response options:

O

Ring forever

This means that the Listener will continue to ring until the caller disconnects.

Ignore this call with no message

This means that calls will automatically be refused and the caller will receive no
feedback from your computer. If thisis selected, you will not be notified of
incoming calls.

Refuse call after x rings with message

This means that you can define how many times the Listener will ring before
refusing calls. If you type a message into the box below this choice, that message
will be sent to the caller once the call is refused. For example, you can send the
following message to your caller:

“1 am not at my computer right now. Please call again later.”

Choose how CU-SeeMe

should respond when
you don’t answer an ™ Ring forever
incoming call. Here, the
call will be refused after ™ lgnare thiz Call with no Message

10 rings and a message
will beg displayed tothg — & Befuse Call after |1Drir15|S =] wiith message.
caller.

Type the message that
you want to caller to

— Call rezponze

receive.

Figure 3-19. You can define how the Listener will respond if you don’t answer the call
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Creating Listener Active Filters

There may be times when you don’'t want the Listener to use the default settings. For
example, you might want to block out calls from one particular caller, but receive
notification when anyone else calls. Or you might want to be notified of callsfrom
only asmall group of special friends. Y ou can override the default settings by creating

Listener Active Filters.

To create Listener Active Filters:

3. Thereisasectionof thisdialog box called Listener ActiveFilters. Click the New
button to createanew filter. The New Listener Filter dialog box appears, as shown
in Figure 3-20.

Use this section to define

1. Click the Call Options button on the toolbar. Point to Listener, then click.

2. TheCU-SeeMeCall Optionsdialog box appears (with the Listener tab displayed),
as shown in Figure 3-15.

Mew Listener Filter [ %]
Filter label : I [+ Activate this filter
—Match
Match values :
T IEU-SeeMe M ame jlls jl"

whose calls will be
filtered.

Figure 3-20. You can customize the Listener for specific incoming calls using filters
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— Get my attention

" Noring [V Open Matify Dialog
& Standard ring ™ Flash lm
" Distinctive ring : none
Brawse.. | ’l .l
— Call responze
& Ring forever

' lgnore this Call with no Message

" Refuse Call after INorings 'l it message;

.

Cancel | Help |




Y ou can create afilter that will override the default Listener settings. For example,
using the sample filter shown in Figure 3-21, if a user with the CU-SeeMe name of
Jason triesto call you, the call will automatically be refused and Jason will receive the
following message:

“1 am not accepting your call at thistime.”

Filter |label : IHefuse call from Jason V| Activate this filter
—Match
Match values :
|CU-Seste Name 7] 15 pason Calls from Jason will be
. filtered
— Get my attention
) Hoiring ¥ | Wmer Wit Dislog
%) Standard ring I | Elash IActive caption bz 'l
) Distnetive itgl none
Brawse.. | ’l .l
— Call responze
' Riing forever
' lgnore this Call with no Message
Calls from Jason ™ & Hefuse Call afer [Norings 7] with message:
will be refused | am nat accepting your call at this time. Jason will receive this
message when his call
is refused
QK I Cancel | Help |

Figure 3-21. This sample Listener Filter will stop incoming calls from Jason

You can also use the Listener Filter to notify you of certain calls even if your default
setting ignores all calls. Simply create a Listener Filter to accept acall from a specific
user. The filters aways override the default settings.

If you create multiple filters, CU-SeeMeimplements the filtersin sequence, from the
top of thelist to the bottom. Y ou can change the sequence of the filters, using the up
and down arrows next to the list of filters, as shown in Figure 3-15.
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Using the Listener

Answering an Incoming Call

If you have selected the default Listener settings, the Listener Status window (see
Figure 3-22) appears when another user is calling CU-SeeMe on your computer.

: Liztener Status x
The CU-SeeMe user name & ]

of the caller is displayed |
@ CU-Guy iz calling you...

Select this to receive the
caller's video when
connected

— Click to display
additional options

b atching filker "Default Behavior,
Thiz call will ber automatically refuzed after 10 rings.

|
. . ¥ Recsive Vi " j
Select this to transmit your IV Regeive Video Iy SendVideo

video when connected lgnare | Refuse | Accept |
1 1

| | |
Click here to ignore the call Click here to refuse the call Click here to accept the call
and send a message (if defined)

Figure 3-22. The Listener Status dialog box notifies you of incoming call

Y ou can choose to accept the call or you can reject the call. You can reject the cal in
twoways. If you click Ignor e, the caller will not connect to your computer. If you click
Refuse, the caller will not connect to your computer and, if you defined amessagein
the Listener Default Settings dialog box (see Figure 3-17), that message will be sent to
the caler.
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Using Parental Control

CU-SeeMe parental control alows you to put restrictions on the CU-SeeMe calls that
are made from your computer and the calls accepted by your computer.

Configuring Parental Control

Y ou can configure parental control to restrict other users from accessing al the
features of CU-SeeMe. Y ou decide which features you want disabled.

To configure parental control:

1. Click the Call Optionsbutton on the Phone Book toolbar. Point to Security, then
click.

2. TheCU-SeeMeCall Optionsdialog box appears (with the Security tab displayed),
as shown in Figure 3-23.

CU-SeeMe Call Options [ %]

Profilesl Listerer  Security | Fhone Bookl
— Parental Control

Usze Parental Control to put limitz on calls that can be made
and received.

| Enable Parental Contral... i Create Password... |

Lonfigure Parental Control Restrictions... |

QK | Cancel | Help |

Figure 3-23. You can configure and enable parental control

3. Click the button labeled Configur e Parental Control Restrictions.The Parental
Control Restrictions window appears.

Chapter 3. Using the Phone Book 3-39

|0U0D [elUaed Buisn



Using Parental Control

4. Click the Communicationstab (see Figure 3-24).
Parontel Control Rostictions KA

Communications | Usagel meilesl

 Incoming call

@ Select this option to allow users to answer incoming calls.

r

— Manual dial

Select this option to allow users to manual dial a call to any
perzon or place.

[ Allaw manual dial

~ Multicast conference:

mFE  Select this option to allow uzers to create and join multicast
conferences.

[ Allow multicast

QK I Cancel | Help |

Figure 3-24. You can restrict incoming and outgoing calls, as well as multicast conferencing
5. Click theitems you want to allow access to.
6. Click OK.

(Mac OS)

Because CU-SeeMefor Mac OS does not support |P Multicast conferences, the Allow
Multicast option is dimmed.
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7. Click the Usage tab (see Figure 3-25).

Parental Control Restrictions

Figure 3-25. You can restrict access to Web launching and Phone Book features

8. Click theitemsto indicate the privileges you want to allow.
9. Click OK.
10. Click the Profilestab (see Figure 3-26).

Parental Control Restrictions

Figure 3-26. You can restrict a user from changing profiles
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Using Parental Control

11. Click theitemsto indicate the privileges you want to allow.

12. Click OK. You are returned to the Security tab.

13. Click OK again.

Y ou have now configured parental control options; however, you have not yet enabled,
or turned on parental control. To do this, read the following section.

Enabling Parental Control

Parental control is password-protected. A parent can set controls which can be turned
on or off and modified only by someonewho knowsthe password.This prevents others
from tampering with the control configurations you chose in the previous section.

To create a password:

click.

as shown in Figure 3-23.

1. Click the Call Optionsbutton on the Phone Book toolbar. Point to Security, then

2. TheCU-SeeMe Call Optionsdial og box appears (with the Security tab displayed),

3. If you have not yet created a password, you will need to do this. Click the Create
Passwor d button. The New Parental Control Password dialog box appears, as
shown in Figure 3-27.

Mew Parental Control Password [ %]

Please, enter the "Parental Control* password to access this
function.

Parental Control password : ||

Parental Control new password : I

LConfirm Parental Control password : I

o]

Cancel |

— Enter an existing password here

— To create a new password, type it here
— Type the new password again, to confirm it

Figure 3-27. Enter or create a password to protect the parental controls

4. Enter an existing password or create a new password. Then click OK.
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To enable parental control:

1. Inthe CU-SeeMe Call Options dialog box (see Figure 3-23), click Enable
Parental Control.

2. Typeyour password in the Parental Control Password dialog box. Thisturnson
parental control.

3. Repeat this step to turn off parental control.

4. Click OK when you are done.
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Multicast Conferences (Windows only)

Multicast Conferences (Windows only)

3-44

CU-SeeMe allows you to conference with multiple users (Windows users only at this
time) in amulticast conference. In amulticast conference, you send a stream of video,
audio, Chat, WhitePineBoard, and conference control data over a network to many
users simultaneously. Joining a multicast conferenceis similar to connecting to a
conference hosted on a conference server. Only userswith CU-SeeMeVersion 2.1 for
Windows (or later) can participate in a multicast conference.

Once the multicast conference has been created (see“ Creating a M ulticast Conference
(Windows only)” on page 3-46), any user can join the multicast conference by
selecting the conference from the Phone Book. Users can also join by connecting
(point-to-point) to any participant who has aready joined the conference. The
Participants List will not display any participants until auser (in addition to the
conference creator) connects to the I P address of the multicast conference.

CU-SeeMemullticast conferencesare“loosely coupled” which meansthat participants
can join the multicast, or disconnect from the multicast at any time. Even the creator
of the conference can disconnect and the conference will continue to exist aslong as
morethan one user isstill connected to thismulticast. When all participants disconnect
from the multicast conference, then that conference no longer exists.

Multicast is a special TCP/IP protocol for sending data over an IP network from a
single source to many recipients. ThisrequiresaTCP/IP stack that supports multicast.
The Microsoft VXD TCP/IP stack, which isincluded with the Windows 95 and
Windows NT operating systems, supports multicast.

Because multicast is arelatively new TCP/IP protocol, not all routers, bridges, and
gateways support multicast. Therefore you may not be able to multicast over the
Internet or over your LAN or WAN. Many modem users may find that they are not
abletojoin or create multicast conferences. If you want to use multicast over your
corporate LAN or WAN, check with your Systems Administrator or your Internet
Service Provider first.

Y our ability to participate in a multicast conference also depends on the network
interface card (commonly called aNIC, or an Ethernet card) installed in your
computer. Please consult your hardware supplier and Internet Service Provider to find
out if they support multicast conferencing. For more information on compatible
network interface cards check the CU-SeeMe Frequently Asked Questions on the
World Wide Web at http://support.wpine.com/cuseeme.
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There are two types of multicast conferences:
O Group Conference

Thisisan interactive conference where all users who are connected can send and
receive audio and video, and can use the other features of CU-SeeMe, such as
Chat and the WhitePineBoard. (See the WPBoard.pdf file for details.)

0 Cybercast

Thisis aone-way conference where only the conference creator can send out
video and audio. Others who are connected can see and hear the “ cybercasted”
audio and video, but they cannot send audio and video.

Multicast conferences have no limit to the number of participants that can join.
However, due to bandwidth considerations, amulticast group (interactive) conference
should generally not exceed100 participants. A multicast cybercast conference
(one-way) hasno limitson the number of participants. Multicast cybercast conferences
will not have a Participants List. However the conference creator can see how many
participants are viewing the broadcast.

Enabling Multicast (Windows only)

Before you can create or join a multicast conference, you must be sure that your
Personal Profileis set to enable a multicast.

To enable multicast:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then
click.

2. TheCU-SeeMe Call Optionsdialog box appears (with the Profilestab displayed),
as shown in Figure 3-12.

3. Click Edit.

4. The Personal Profile Editor appears, as shown in Figure 3-14. Select the General
tab.
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Multicast Conferences (Windows only)

5. Select the Enable Multicast Connections check box to turn on the ability to
participate in multicast conferences. When you select this check box, CU-SeeMe
will check to seeif a TCP/IP stack with multicast support isinstalled in your
computer. If this stack isfound, then this box will remain selected. If an
appropriate TCP/IP stack isnot found, this box will revert to being unselected and
you will not have the option of creating or joining a multicast conference.

6. Click OK.

Creating a Multicast Conference (Windows only)

If you have multicast-capable network connections and you have multicast enabled,
you can create a multicast conference. CU-SeeMe includes a Multicast Assistant to
guide you.

To create a multicast conference:

1. From the Call menu, click Create Multicast Conference.

2. The Multicast Conference Assistant is displayed, as shown in Figure 3-28.

Welcome to the Multicast Assistant!

There are 3 steps to create a mulicast conference.
“Y'ou are now on step 1.

“You will create a multicast conference, allowing you to send a stream of video, audio and conference
data over a network to many users simultaneously. Other users can join your multicast conference,
which iz zimilar to connecting to a conference server.

@ Define the type of conference you want to create
IEI Enter infarmation to describe the conference

IEI Enter contact infarmation

< Back

Cancel | Help |

Figure 3-28. The Multicast Conference Assistant makes it easy to create a multicast conference

3. Click Next to define the type of multicast conference you want to create.
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Click the Group conference option to create an interactive conference where all
participants can exchange video and audio, Chat, and share WhitePineBoard
workbooks.

_or-

Click the Broadcast confer ence option to create a one-way conference (a
cybercast) where only you can send video and audio. Participants who connect to
this conference can see and hear you, but they cannot send data.

Select an areafrom the Ar ea drop-down list. These areas determine how far your
multicast conference will reach. Before selecting Region, Continent, or World as
your multicast conference area, contact your network manager to ask whether you
have the appropriate Internet access.

e Subnet - Stay within your local area network (LAN). Y our multicast will not
go through routers.

 Site- Stay within your Wide Area Network (WAN). For example, your
multicast may stay within your corporate network. Thiswill work only if your
WAN has multicast routers.

» Region - Extend to the Internet for adefined Timeto Live (TTL). Your
multicast will be limited to adefined area on the Internet. Click Advanced
Configuration to definethe TTL.

» Continent - Extend to the Internet for an extended Timeto Live (TTL). Your
multicast will belimited to adefined areaon the Internet. A Continent will have
agreater Timeto Livevaluethan aRegion. Click Advanced Configuration to
definethe TTL.

« World - Extend to the widest range for adefined Timeto Live (TTL). Your
multicast will be capable of extending globally. Click Advanced
Configuration to definethe TTL.

Click Next. Click Next again to enter information to describe the conference.

Type a conference name. Thiswill appear in the Phone Book of any CU-SeeMe
user who is able to connect to your conference. See* Joining a Multicast
Conference (Windows only)” on page 3-48 for information about how multicast
conferences appear in the Phone Book.

Type adescription of your conference. Thiswill appear on a Contact Card for
your multicast conference. This Contact card will also appear in the Phone Book
of any CU-SeeMe user who is able to connect to your conference.

Click Next. Click Next again to enter contact information.
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Multicast Conferences (Windows only)

10. Contact information allows other usersto contact you for more information about
the multicast conference you have created. Thisinformation is optional. Y ou can
type your name, a URL for your Web page, and your phone number. Y our Web
page could include information about your multicast conference. Y our phone
number allows people to contact you directly viathe telephone. Remember to
include your compl ete phone number because participants in your conference
could be located anywhere in the world.

11. Click Next. Y ou are now presented with aContact Card for your conference. This
will automatically appear in the Phone Book of any user who is ableto connect to
your conference.

12. Click Finish. This closes the Multicast Assistant and begins the multicast
conference.

Joining a Multicast Conference (Windows only)

If you have multicast-capable network connections and you have multicast enabled,
you can join multicast conferences. All multicast conferencesthat are availableto you
are listed in your Phone Book.

To join a multicast conference:
1. OntheView menu, point to Groups.
2. Point to the Multicast Contact Group, then click.

3. Themulticast group is now displayed in your Contact Card list and the first card
inthelist isshown asthe selected card. Y ou can call amulticast conference asyou
would call any other conference. (See “Making Calls from the Phone Book” on
page 3-16.) If thislist is empty, it means that no multicast conferences are
currently available to you.
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White Pine

Chapter 4

Using the Conference
Room

The CU-SeeMe interface has two main windows: the Phone Book and the
Conference Room. This chapter explains how to use the Conference Room. See
Chapter 3 for information on how to use the Phone Book. To enter the Conference
Room, you must make a call from either the Phone Book (see “Making Calls from
the Phone Book” on page 3-16) or the Quick Start window (see “ Connecting to the
White Pine Cafe” on page 2-10).

The Conference Room window is where videoconferencing takes place. Think of it
as avirtual meeting room where you see and talk to others. Whether you are
connected in a point-to-point conference, a group conference, or a cybercast, you
will be doing it in the Conference Room.

The Conference Room window was introduced in Chapter 2. This chapter describes
additional features.
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Components of the Conference Room

Components of the Conference Room

The components of the Conference Room window are shown in Figure 4-1.

Menus

Toolbar

Participants
List

Audio
controls and
indicators

Status bar

« White Pine Cafe Conference [3]

File  Edit

Conference Window  Help

[_[O1x]

-
Yideo

b @ = S
Speak Ta Custamize Hang Up

Push to speak

o &)
e [ <) o — Video windows
= E )
e [ =)o
WO
Guillaume e &)
Katrina w1
Elvis EOF 4
Jacques )
T I— EI| || Phit: | love this latest version of OL-Sesb! e Chat window
— Heidi: ) kids use it 10 chat with their friends after school.
[T Ton | uss it at work 10r group rrestings.,
L - Willy: We're always rree?i’ng r?ew peog\se on the Internet!
—_— Bill: [ just downloaded the latest version from httpuhswweuseerme.com.
Speaking to everyone And [ound a list of cybercast events 100! This s so coal.-) j
@ [ Public Chat ” o = =]
Bill spoke last ICU on the Net!

Figure 4-1. The Conference Room window

The components are explained in the following sections, as shown in Table 4-1.

Table 4-1. Where to find information on Conference Room components

To find out information about... Go to...
Conference Room Menus page 4-3
Conference Room Toolbar page 4-10
Participants List page 4-12
Video Windows page 4-19
Chat Window page 4-26
Audio Controls and Indicators page 4-36
Status Bar page 4-38
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Conference Room Menus

Y ou can access CU-SeeM e commands from the Conference Room menu. Y ou activate
amenu by clicking on it. When you do, the menu’s commands are displayed. If a
command is not available to you, it appears dimmed. Commands in the menu that are
followed by ellipsis(...) need more information from you before they execute. These
commands display dialog boxes that ask you for more information. Commandsin the
menu that are followed by atriangle indicate that a submenu is available. Pause your
mouse pointer over that command and a submenu will appear.

Explanations and descriptions of the Conference Room commands for both Windows
and Macintosh start on page 4-4.

The CU-SeeMe Menu for Mac OS

There are some differences in the appearance of CU-SeeMe, depending on whether it
is running on the Windows or Mac OS operating system. One notable differenceis
that, in Windows, the menu islocated at the top of the Phone Book or Conference
Room window. Figure 4-1 shows the menu at the top of the Conference Room in
Windows. In the Mac OS, the menu bar is not attached to the Phone Book or to the
Conference Room window. Instead, it is aways found at the top of your screen.

The CU-SeeMe menu bar for Mac OS is shown in Figure 4-2.

File Edit Call Conference Window Help

Figure 4-2. The CU-SeeMe menu bar for Mac OS is always at the top of your screen

This menu bar displays all of the CU-SeeMe menu items. Y ou can access CU-SeeMe
commands from these menu items. Some commands may be available only when you
are using the Phone Book, and other commands may be available only when you are
in the Conference Room. Unavailable commands appear dimmed. (The Help menu for
Mac OS 8 appears on the menu bar, as shown above. In earlier Mac OS versions, the
Help menu appears as a question mark 3J at the top right corner of the screen.)

Commands specific to Windows or Mac OS in the following tables are noted with
parentheses (). Only active Conference Room commands are included, so Mac OS
commands that are unavailable from the Conference Room are not explained in this
chapter. Refer to Chapter 3, Using the Phone Book, for a description of commands
available from the Phone Book window.
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Conference Room Menus

File Menu

The commands under the File menu are described in Table 4-2.

Table 4-2. The commands under the File menu in the Conference Room

File Command

Description

Close Disconnects you from your current
connection and closes the Conference
Room window. The Phone Book window
remains on your screen.

Save Chat... Displays a dialog box where you can save

the contents of the Upper pane of the Chat
window to a file.

Save Chat As

Displays a dialog box where you can save
the contents of the Upper pane of the Chat
window to a file that you can rename.

Send Mail...

Opens your default e-mail program. (Note
that your e-mail program must be
configured to use MAPI. See your e-mail
vendor’s documentation to learn if it is
MAPI-compliant.)

Page Setup...

Displays the Print Setup dialog box where
you can change the printer and print
options.

Print...

Displays the Print dialog box, where you
can print Chat text or video images.

Exit (Windows)
Quit (Mac OS)

Disconnects you from your current
connection and exits the CU-SeeMe
program.

4-4 CU-SeeMe User Guide




Edit Menu

The commands under the Edit menu are described in Table 4-3.

Table 4-3. The commands under the Edit menu in the Conference Room

Edit Command

Description

Undo Reverses the last text edit in the Chat
window input pane.

Cut Cuts the selected Chat text and puts it on
the Clipboard.

Copy Copies the selected Chat text to the
Clipboard.

Paste Pastes the current content of the Clipboard.

Delete Deletes the selected Chat text.

Select All Selects all the Chat text.

Call Options (Mac OS)

Displays the Call Options dialog box where
you can change settings for Profiles,
Listener, Security, and Phone Book options.

This command is also available by clicking
the Call Options button on the Phone Book
Toolbar.

Customize...

Displays the Customize dialog box where
you can change settings for the Conference
Room including video layout, Chat, audio,
video, network and more.

This command is also available by clicking
the Customize button on the Conference
Room toolbar.

Current Profile... (Mac OS)

Displays the Personal Profile Editor dialog
box, where you can modify your Personal
Profiles. (If you are currently connected to a
conference, you will have to disconnect
from the conference before modifying your
current profile.)
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Conference Room Menus

Call Menu (Mac OS)

Note: The Conference Room in CU-SeeMe for Windows has no Call menu.

The commands under the Call menu are described in Table 4-4.

Table 4-4. The commands under the Call menu in CU-SeeMe for Mac OS

Call Command

Description

Favorites >

Displays a list of Contact Cards in your
Favorites Contact Group. You can select a
card from this group and call the person or
place listed on the card.

Manual Dial...

Displays the Dial dialog box where you can
type an IP address to make a call. (If you
are currently connected to a conference,
you will have to disconnect from the
conference before dialing another.)

Who's Online...

Displays a list of users who are currently
online using CU-SeeMe (and are registered
with Fourl1 directory service).

Directory Services...

Opens a Web browser and connects to the
Fourll directory service Web page.
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Conference Menu

The commands under the Conference menu are described in Table 4-5.

Table 4-5. The commands under the Conference menu in the Conference Room

Conference Command

Description

Speak To >

Displays a list of conference participants.
Click on a name in the list to send audio to
only that person. If you do not select a
name, you will send audio to everyone in
the conference. Windows users must have
a sound card and microphone to send
audio.

This command is also available by clicking
the Speak To button on the Conference
Room toolbar.

Mute >

Displays a list of conference participants.
Click on a name in the list to stop
receiving audio from that person. If you do
not select a name, you will receive audio
from everyone in the conference.
Windows users must have a sound card
and speakers to receive audio.

Chat to >

Displays a list of conference participants.
Click on a name in the list to send Chat
text to the selected person only. This is
called Private Chat. If you do not select a
name, you will send Chat to everyone in
the conference. This is called Public Chat.

Video >

Displays a list of conference participants
who are sending video. Click on a name in
the list to display that participant’s video.

This command is also available by clicking
the Video button on the Conference
Room toolbar.

Get Contact Card of >

Displays a list of conference participants
who have Contact Cards available. Click
on a name in the list to get that person’s
contact card.

Get Participant Info (Mac OS)

Displays the information window for a
selected participant.

Chapter 4. Using the Conference Room
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Conference Room Menus

Table 4-5. The commands under the Conference menu in the Conference Room

Conference Command Description

Hold Temporarily freezes the audio and video
that you send and receive. It does not
freeze Chat text.

Speakers Turns your speakers on and off.

Hang Up Disconnects you from the current
conference and closes the Conference
Room.
This command is also available by clicking
the Hang Up button on the Conference
Room toolbar.

Window Menu

The commands under the Window menu are described in Table 4-6.

Table 4-6. The commands under the Window menu in the Conference Room

Window Command

Description

Quick Start & Tips... (Mac OS)

Displays the Quick Start & Tips window.

Phone Book

Displays the Phone Book window.

This command is also available by clicking
the Phone Book button on the Conference
Room toolbar.

WhiteBoard (Windows)

Starts the WhitePineBoard program. Brings
the WhitePineBoard window to the front if
you are currently running the
WhitePineBoard. (For details, refer to the
WPBoard.pdf file.)

This command is also available by clicking
the WhiteBoard button on the Conference
Room toolbar.

4-8 CU-SeeMe User Guide




Help Menu

The commands under the Help menu are described in Table 4-7.

Table 4-7. The commands under the Help menu in the Conference Room

Help Command

Description

CU-SeeMe Help Topics

Opens the CU-SeeMe Help file and displays
the contents of the Help file.

Search for Help On (Windows)

Opens the CU-SeeMe Help file and displays
the Find page.

CU-SeeMe Events

Opens a Web browser and displays a Web
page showing a schedule of events to which
you can connect with CU-SeeMe.

Technical Support

Opens a Web browser and displays the
White Pine Software Technical Support Web

page.

Registration

Opens a Web browser and displays the
White Pine Software Product Registration
Web page, allowing you to register your
copy of CU-SeeMe online.

Quick Start & Tips

Displays the Quick Start and Tips window.

About CU-SeeMe... (Windows)

Displays information about your version of
CU-SeeMe.

In the Mac OS, this command is found
under the Apple g§ menu.

Chapter 4. Using the Conference Room
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Conference Room Toolbar

Conference Room Toolbar

The Conference Room toolbar has buttons that provide shortcuts to many commands.

As you move your mouse pointer over each button, the selected button becomes
highlighted. Y ou can then click the button to select it.

When you pause your mouse pointer on each button, atool tip appears. No clicking is

necessary. The tool tip gives you information about the function of each button.

The Conference Room toolbar buttons are explained in Table 4-8.

Table 4-8. The Conference Room toolbar buttons

Toolbar Button

Description

Displays the Phone Book window.

Phone Book
Starts the WhitePineBoard program.
v ey (Windows only)
- rld O,
WhiteBoard
Displays a list of conference participants
who are sending video. Click on a name in
the list to display that participant’s video.
Video

Also allows you to fill all available video
window frames with video images (Open
All), or close all video images on your
screen (Close All).

Displays a list of conference participants.
Click on a name in the list to send audio to
only that person. If you do not select a
name, you will send audio to everyone in
the conference. Windows users must have a
sound card and microphone to send audio.

W s
ke
@
o)
by
3

Customize

Displays the Customize dialog box where
you can change settings for the Conference
Room including video layout, Chat, audio,
video, network and more.
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Table 4-8. The Conference Room toolbar buttons

Toolbar Button

Description

v

Hang Up

Disconnects you from the current
conference and closes the Conference
Room.
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Participants List

Participants List

The Participants List shows the names of the people currently in the conference. In
addition to listing names, the Participants List shows information about each of the
participants, such as whether the person is a sender (sending a video image) or lurker
(not sending a video image), is watching your video, and more. Once you understand
which participants are senders and lurkers, you can decide whose video images you
want to display on your screen. Y ou can try to display the video image of alurker, but
instead of a picture you will get a blank frame with a message telling you that the
chosen participant has “No Video Stream.”

To learn how to display the video images of participants in aconference, see“ Seeing
Video Images’ on page 4-19. To learn how to change your own status from a sender
to alurker (and back again) see “Being Seen” on page 4-21.

Participants List Views

The Participants List displays the CU-SeeMe user name of each person in the
conference, as well as status information about each participant. Y ou can choose
whether to view the Participants List as a detailed list, or as a group of large or small
icons. By default, CU-SeeMe displaysthe Participants List asadetailed list. Try each
view and choose the one that you prefer.

If you choose to view the Participants List asicons, then the information about each
participant is conveyed using pictures. These pictures, or icons, illustrate whether the
person is asender or lurker, iswatching your video image, and more.

To learn more about the detailed list view, see“ Participants List Viewed asa Detailed
List” on page 4-14. To learn more about the small icon view, see “ Participants List
Viewed as Small Icons’ on page 4-16. To learn more about the large icon view, see
“Participants List Viewed as Large Icons’ on page 4-17.
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To change the Participants List view:

1. Click the Customize button on the Conference Room toolbar. Point to General,
then click. The Customize dial og box appears (with the General tab displayed), as
shown in Figure 4-3.

Chat Extenzions I Hardware I Configuration I
General | Wideo Lapout I Chat Style

—E |
General

v I' V' Auto-open new participants
¥ | ShoviEhat Parel V' Show Toolbar
V' Show Participants List V' Show Toolbar test labels
Sounds... |
— Participants List
Sort on: ISendingVideo 'l ™ Automatically sort
Select how you
want to VieV\ythe ™ Wiewas: % agist  azsmalicons  © as large jcons
Participants List ™ Show estended information
— Overlay
[V Participart name = | LAl videnteqt

—

™ Always use these seftings for this connection

QK I Cancel | Lol |

Figure 4-3. You can choose from three Participant List views

2. Select aParticipants List view (aslist, as small icons, or aslarge icons).

3. Click OK when you are done. The selected Participants List is now displayed in
your Phone Book.

(Mac 0S)

TheMac OS version of the General tab on the Customize dial og box does not havethe
Always use these settings for this connection check box.
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Participants List

4-14

Participants List Viewed as a Detailed List

By default, CU-SeeMe displaysthe ParticipantsList asadetailed list. The detailed list
shows the names of al the participants in the conference. It also showsicons,
organized in columns, which indicate different things about the status of each
participant. These icons are explained in Table 4-9.

Table 4-9. Icons in the detailed list

This icon... Indicates this about the participant...
b This participant is sending video.
D This participant’s video is currently displayed on your screen.
B This participant is currently watching your video.

This participant and you are both watching each other’s

2 videos.

Fd:' This participant is hearing audio that you send.

ﬁ This participant can send audio.

ﬁ You have muted this participant. Therefore, you will not hear

any audio sent by this participant.
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Figure 4-4 shows how these icons appear in the Participants List.

Issending ~ Who'sseeing Ishearing  Cansend
video whom | you audio

_Participant
L You are both seeing
Phil (= each other
Tom s
Heidi
Bill's name is E I = = You are seeing him
underlined and in rBill e ] =) (this person’s video is
bold to indicate he Guillaume s L displayed on your screen)
was the last person . — He is seeing you
to send audio K.atrina ' ) (this person has your
Elviz =) ﬁ video displayed)
Jacques :;]) &—— You have muted this person
N I

Figure 4-4. The Participants List shown as a detailed list

Y ou can click on the heading at the top of each column to sort the list:

O

O

O

Click on the Participant heading to sort the list so that the user names appear
alphabetically.

Click onthe kg heading to sort the Participants List so that all the senders are
grouped at the top and all the lurkers are grouped at the bottom.

Click on the heading to group all the users who are currently seeing you.
Click on the ;q:, heading to group all the users who have speakers turned on.

Click on the ﬁ heading to group all the users who can send audio.

Y our name will always appear at the top of thelist. Y ou can extend the columnsin the
detailed list to show additional information about the participants.

To see extended information:

1

(Windows) Using the right mouse button (right-click), click on ablank areaof the
Participants List, such as the area below the list of names. A shortcut menu

appears.
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Participants List

(Mac OS) Hold down the CONTROL key as you click on ablank area of the
Participants List, such as the area below the list of names. A shortcut menu

appears.
2. Point to Extended I nfo, then click.

3. TheParticipants List now displays additional columns of information. Y ou may
need to scroll the Participants List to theright or resize the Participants List to see
al theinformation. (See “Resizing the Participants List” on page 4-18 to learn
how to enlarge the Participants List.)

Y ou can aso display the extended information by selecting the Show extended
infor mation check box shown in Figure 4-3.

The new columns of information show the video and audio codec used, aswell asthe
IP Address of each participant. To hide the extended information, repeat the previous
steps (or deselect the Show extended infor mation check box shown in Figure 4-3).

To learn how to view the Participants List in alternate ways, see “Participants List
Views' on page 4-12.

Participants List Viewed as Small Icons

When you choose to view the Participants List as small icons, asmall icon appears
next to each name in the Participants List. Understanding these icons will enable you
to know who is seeing you, hearing you, and more. Figure 4-5 explains the
components of asmall icon that represents a participant in a conference.

A box around the icon ————— Is sending video
means that this person is .
currently displayed on 52 Is looking at you

your screen Is listening to you

Figure 4-5. The components of the small icon used in the Participants List

Figure 4-6 shows the meaning of the small icons used to represent you (the local
participant) in a conference.

\ ___ This represents you when your video
& image is not displayed on your screen
This represents you when your video
% image is displayed on your screen

Figure 4-6. These icons represent you (the local participant) in the small icon view
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Participants List Viewed as Large Icons

When you chooseto view the Participants List aslargeicons, alargeicon appears over
each namein the Participants List. Understanding theseiconswill enable you to know
who is seeing you, hearing you, and more. Figure 4-7 explains the components of a
large icon that represents a participant in a conference.

A box around the icon L
means that this person is 'E}’ Is sendmg video
currently displayed onyour ¥, €@ Is looking at you
screen 1.11) Is listening to you

Figure 4-7. The components of the large icon representing a remote participant

Figure 4-8 shows the meaning of the large icons used to represent you (the local
participant) in a conference.

__ This represents you when your video
image is not displayed on your screen

__This represents you when your video
image Is displayed on your screen

B
]

1SI7 Suedionred

Figure 4-8. These icons represent you (the local participant) in the large icon view

Moving the Participants List (Windows only)

The Participants List can be moved from the left side of the Conference Room to the
right side. It can a'so be dragged out of the Conference Room window, becoming a
separate, floating window.

To move the Participants List:

1. Click on the frame around the Participants List.

2. Hold the mouse button down while you drag the Participants List to theright side
of the Conference Room. Release the mouse button. If you have enough room on
your monitor screen, you can drag the Participants List out of the Conference
Room. Thistechnique is called drag-and-drop.

3. You can drag-and-drop the Participants List back to its original location at any
time.
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Participants List

Note that when you move the Participants List, the audio controls and indicators move
also. When you move them out of the Conference Room, they form a new window
called the Conference Control Center, as shown in Figure 4-9.

Conference Control Center E

Formest. LS00 Eﬂ) ﬁ
Phil i & ) o
Tom (=) ;4) ﬁ
Heidi (o Eq) ﬁ
Bt NP
Guillaure ' 5] o
K.atrina (=] &) ¥
Elviz =) 38
Jacques &]) o
N [ ol

e |
Speaking to everpane

;lil

T
J—
Bill spoke last

Figure 4-9. You can drag-and-drop the Participants List and audio controls out of the Conference
Room window (Windows only)

Resizing the Participants List

Y ou can change the size of the Participants List to make it more narrow or wide.

To resize the Participants List:

1. Moveyour mouse pointer over the splitter bar between the Participants List and
the Video windows. The mouse pointer changes to a double arrow.

2. Click and drag the splitter bar to the right or left to change the size of the
Participants List.
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Video Windows

Video images of conference participants appear in video window framesin the
Conference Room. Y ou can display multiple video windows simultaneously.

Seeing Video Images

Some participants in the conference may be sending video images (these people are
called senders). Some participants may not be sending any video (these people are
called lurkers). Y ou can choose which senders’ video images you want to see
displayed on your screen. Y ou can try to display the video image of alurker, but
instead of a picture you will get a blank frame with a message telling you that the
chosen participant has “No Video Stream.”

To see a participant:

1. Click the Video button on the toolbar. This displays alist of all the participants
@ who are sending video images.
2. Point to the name of the participant you want to select, then click.

3. That person’svideo image is now displayed in one of the open video window
frames on your screen.

4. You can repeat this process to see video images of other participants.

SMOPUI O3PIA

Y ou can continuethisuntil all the video window framesarefull, or you can stop at any
time. You do not need to fill al the video windows. In fact, having fewer open video
windows will increase the performance of your computer during the videoconference.

In addition to the steps described previously, there are other ways you can display the

video image of a participant. These methods are described next.

Other ways to see a participant:

O Double-click on a participant’s name. That person’s video image will appear in
one of the open video window frames.

-0r -

O Double-click on an empty video frame. The Open Participant dialog box
appears. Select a participant and click OK.

_or-
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Video Windows

O Click aparticipant’s name to select it, and then drag it to an open video window
frame. (Thisiscalled drag-and-drop.) That person’s video image will appear in
the window frame to which you dragged it. This method allows you to place a
video image in aspecific frame. If you drag the participant’ s name to aframe that
aready has avideo image, the new participant’simage will replace the previous
image.

_Or-

0 On the Conference menu, point to Video. This displays alist of conference
participants who are sending video. Click on a name to display that person’s
video.

_Or-

O (Windows) Using the right mouse button (right-click), select a participant’s
name. A shortcut menu appears. Click Show Video. That person’s video image
will appear in one of the open video window frames.

O (Mac OS) Hold down the CONTROL key asyou click on a participant’s hame
(CTRL-click). A shortcut menu appears. Click Show Video. That person’svideo
image will appear in one of the open video window frames.

Closing Video Windows

Y ou may want to close some of the video windows displayed on your screen. Y ou can
use the same methods that you used to display the video windows.

To close a video window:

who are sending video images. The participants who are currently displayed on

1. Click the Video button on the toolbar. This displaysalist of al the participants
% your screen areindicated by a0 in thislist.
2. Point to the name of a participant who is displayed on your screen, then click.

3. That person’svideo imageis no longer displayed in avideo window frame on
your screen.

4. You can repeat this process to close video windows of other participants.

In addition to the steps described previously, there are other ways you can close the
video image of a participant. These methods are described next.
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Other ways to close a video window:

O

Double-click on a participant’ s name. That person’s video image is no longer
displayed in a video window frame on your screen.

_or-

Using the right mouse button (right-click), select a participant’s name in the
Participants List. A dialog box appears. If that person’svideo is currently
displayed on your screen, you will see a0 next to Show Video. Click Show
Video. That person’ svideo imageisno longer displayed in avideo window frame
on your screen.

-0r -

Using the right mouse button (right-click), select avideo window. A dialog box
appears. Click Hide.

_or-

Double-click on a displayed video window. That person’s video image is no
longer displayed in a video window frame on your screen.

_or-

On the Confer ence menu, point to Video. This displays alist of conference
participants who are sending video. The participants who are currently displayed
on your screen are indicated by a 0. Point to the name of a participant who is
displayed on your screen, then click. That person’s video image is no longer
displayed in a video window frame on your screen.

Being Seen

Just as you can choose to see other people in the Participants List, other participants
can also choose to see you if you are a sender. Remember, if you have a camera
connected to your computer, you are a sender. However, you can choose to become a
lurker, which prevents others from seeing your video picture.

To switch between being a sender and a lurker:
(Windows)

1

Make sure that your local video image is displayed in one of the video window
frames. If it isnot currently displayed, see” To see aparticipant.” on page 2-16 to
learn how to display your video window.
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Video Windows

2. Using the right mouse button (right-click), click on your video image. A shortcut
menu appears. If you see al next to Send Video, then you are a sender.

3. Click Send Video to become alurker. The O disappears. Y ou have stopped
sending your video image to other participants

4. If youclick Send Video again, you become a sender. Y ou have now turned your
video on and other participants can choose to see your video picture.

(Mac OS)

1. Make surethat your local video image is displayed in one of the video window
frames. If it isnot currently displayed, see“ To see aparticipant:” on page 2-16 to
learn how to display your video window.

2. Hold down the CTRL key asyou click on your video window (CTRL-click). A
menu appears. If you seeae next to Send Video, then you are a sender.

3. Click Send Video to become alurker. The * disappears. Y ou have stopped
sending your video image to other participants

4. If youclick Send Video again, you become a sender. Y ou have now turned your

video on and other participants can choose to see your video picture.
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Changing the Layout of the Video Windows

Y ou can arrange your video window framesto allow different combinations and sizes
of video windows.

To change the video layout:

1. Click the Customize button on the Conference Room toolbar. Point to Video
L ayout, then click. The Customize dial og box appears (with the Video Layout tab
displayed), as shown in Figure 4-10.

Chat Extenzions | Hardware | Configuration I
Move the slider to General Videalaot | ChatSyle
select the number of 1
video windows you M awimum number of videos: 'T )ﬁ 4
want to display.
1 2 4
Once you have selected ——— 3
the number of windows,
you can click to choose
the layout from the
options displayed. 1 3 <
=
@D
2 4 o
=
>
| | =3
Select this check box =
to use a custom ™ Use custorn background color | wm
background color
around the video windows. [ ok | cancel &
- Apply
(Windows only) | |

Figure 4-10. You can customize the number and layout of video windows on your screen

2. Movethe dider to select the maximum number of video windows you want to
display.

3. Onceyou have selected the number of windows, the layout options are displayed
in the dialog box.

« (Windows) In some cases, only one layout option is available; in other cases
multiple layouts are available. Click on alayout to select it.

e (Mac OS) Click <<Previous Layout or Next L ayout>> to display different
layout options. Click OK to select alayout.

To use background color (Windows only):

1. If you want to customize the color that appears in the border around the video

Chapter 4. Using the Conference Room 4-23



Video Windows

window frames, click to select the option named Use custom background color
on the Video Layout tab.

2. ClicktheColor button. The Color dialog box appears. Click to select acolor from
the basic colorstable. If you want more color choices, click Other. Chose acolor
from the palette shown. Use the slider to the right of the custom color palette to
fine-tune the exact color you desire. When you have chosen the color you want,
click OK. This closes the Color dialog box.

3. Click OK when you are done. The video layout you selected is now shown in the
Conference Room.

Moving Video Windows

Once you have a video image displayed on your screen, you can move that imageto
other locations on your screen. Y ou can even drag it out of the Conference Room
window, where it becomes a separate, floating window!

To move a video window:
1. Click on avideo image displayed on your screen.

2. Hold the mouse button down while you drag the video image. Rel ease the mouse
button when you have dragged the image where you want it to go. For example,
you can drag theimage and drop it on your Chat window, or even outside of your
Conference Room window. Now you can resize the video image.

* (Windows) Pause your mouse pointer over one of the edges of the video image
frame, or over a corner of the frame. The pointer turns into a double arrow.
Click and drag the double arrow to enlarge the video image. Y ou can make the
image as big as you want. Y ou can shrink the image by dragging the double
arrow again.

» (Mac OS) Click the size box (the squarein the lower, right corner of the video
image frame) and drag it to enlarge the video image. Y ou can make the image
as hig as you want. Y ou can shrink the image by dragging the size box again.

3. If you want to return the video image to the Conference Room, simply
drag-and-drop it on the video window frames in the Conference Room window.
Theimagewill drop into the Conference Room and will automatically resizeitself
to fit the open frame.

Y ou can a so drag-and-drop aname from the Participants List to any other location on
your screen to display that participant’s video image.
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Resizing the Video Window display area

Y ou can changethe size of the Video Window display areato makeit larger or smaller.
The video images will automatically adjust to fit the new size.

To resize the video window display area:

1. Move your mouse pointer over the splitter bar between the Participants List and
the Video windows. The mouse pointer changes to a double arrow.

2. Click and drag the splitter bar to the right or left to make the video images wider
or narrower.

3. Now, moveyour mouse pointer over the splitter bar between the Chat window and
the Video windows. The mouse pointer changes to a double arrow.

4. Click and drag the splitter bar up or down to make the video images taller or
shorter.
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Chat Window

Chat Window

Y ou can use Chat to exchange typed messages with other participants. Thisis
especialy helpful if either you or other users don’t have cameras or microphones, or if
your bandwidth connection istoo limited to carry audio.

The Chat window islocated in the lower right portion of the Conference Room
window and is divided into two sections (or panes), separated by arow of toolbar
buttons and macro buttons, as shown in Figure 4-11.

syzpagy: hello evenone
DawidD: Hey, check out the latest at http: /v, cusesme. coml hat di

; ial
Willy: zn't CU-Seete awesome! dCiSaltad g ﬁgre
spzygy: let me launch that right now from my chat window play
Woodinator: | will too.

Click to erase all
Chat text in the |

upper (display) pane Publc Chat | é}; ¢ H &—
Hi Friends! Type your
Click to filter selected message here

Chat text Click to save Chat Click to print
text as a file Chat text

Figure 4-11. The Chat window contains two panes, toolbar buttons, and macro buttons

To type Chat text:
1. Typeamessagein the lower pane of the Chat window. Thisisthe input pane.

2. PressENTER. Y our message now appearsin the upper pane of the Chat window.
Thisisthe display pane where the chat dialog appears.

Other users will see your message and you will see the messagesthey aretyping. You
can follow Chat conversations in the upper pane of the window. Messages appear in
the order they are received.

Customizing Chat Style

Y ou can modify the way text appearsin the Chat window.

To customize Chat style:
(Windows)

1. Click the Customize button on the Conference Room toolbar. Point to Chat
é Style, then click. The Customize window appears (with the Chat Style tab
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displayed), as shown in Figure 4-12.

Customize E

Chat Extensions I Hardware I
General I Wideo Lapout

Configuration
Chat Style

—Style
Category:

I Chat Text 'l

[MS Sans Seri

— URL Highlighting
¥ Enable LUFRL Highlighting

[V Enable URL Launching

 Kepword Highlighting
[V Enable Keyward Highlighting

sed | Do |

Edif

()8 I Cancel |

Apply

Figure 4-12. (Windows) You can customize the appearance of Chat text

Select acategory of text that you want to customize, such as all Chat Text,

Participant Name, or URL.

Select afont type, size, and color. Select bold, italic or underlined text.

MOPUIM Teyd

Select Enable URL Highlighting to display URLsin adifferent font. (A URL,
or Uniform Resource Locator, is an address used to locate information on the
Internet. An example of aURL is http://www.wpine.com.) Select Enable URL
Launchingto turn URL’sin the Chat window into active links that launch aWeb

browser and connect you to that URL.

Select Enable Keyword Highlighting to assign specific wordsin the Chat

window to appear in adifferent font or color. For example, if you want the words
White Pineto appear in the color red in bold, 12 point size whenever it appearsin

a Chat discussion, follow these steps:

 Click to select Enable Keyword Highlighting.

e Click Add. The Add/Edit Text dialog box appears.

* Changethefont sizeto 12.
« Changethe color to red.

* Click the bold button.
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Chat Window

* Inthetext box, type Wi t e Pi ne.
» Click OK.

6. Click OK when you have completed customizing the Chat style.

To customize Chat style:

(Mac OS)

1. Click the Customize button on the Conference Room toolbar. Point to Chat
Style, then click. The Customize window appears (with the Chat Style tab
displayed), as shown in Figure 4-13.

Customize

General | Wideo Layout Chat Style | Chat Extensions | Hardware | Configuration

—Chat Style ———  —Keyword Highlighting

Koy werd ighlighting Sllow you 25 define
Cat Chat Text Sty
stegory: _ChatTextstyle v | Keeg words that will be Fighlighted in the chat

sheam. Chek on the Add button do define 3
Rew Key word.
Font: Genesva -
Size: 10 - I
e L]
Colar: - Set Tewt Color

Sample

With CU-SeeMe, you can see what | am
saying !
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Figure 4-13. (Mac OS) You can customize the appearance of Chat text

2. Selectacategory of text that you want to customize, such as Chat Text, Participant
Name, Keywords or URL.

(A URL, or Uniform Resource Locator, is an address used to locate information
on the Internet. An example of a URL is http://www.wpine.com. Y ou can
highlight aURL, which can be turned into an active link on the Chat window that
launches a Web browser and connects to that URL.)

3. Select afont type, size, and color. Select bold, italic or underlined text.
4. Click OK when you have completed customizing the Chat style.

5. UseKeyword Highlighting to assign specific wordsin the Chat window to
appear in adifferent font or color. For example, if you want the words White Pine
to appear in the color red, in bold, 12 point size whenever it appearsin a Chat
discussion, follow these steps:

» Click Add inthe Keyword Highlighting section of thetab. The Add/Edit Text
dialog box appears.

4-28 CU-SeeMe User Guide



e TypeWii te Pineandclick OK.

« Inthe Chat Style section of the tab, select the category K eywor ds style.
e Changethefont sizeto 12.

» Change the color to red.

* Click the bold button.

» Click OK.

Using Chat Macros

A macro isaseriesof simple commandsthat allow you to automate tasks. Y ou can use
macrosin the Chat window to eliminate typing of words, phrases, or symbolsthat you
use often. Macros can be used for such things as your e-mail address, your favorite
phrase, or even asmiley face.

To create Chat macros:

1. Click the Customize button on the Conference Room toolbar. Point to Chat
Extensions, then click. The Customize window appears (with the Chat
Extensions tab displayed), as shown in Figure 4-14.

General | Wideo Lapout I Chat Style I
Chat Extensions | Hardware I Configuration

— Chal
m

Add Delete Edit

— Filter Participant
Include List: Exclude List:

Cl-Guy
< |nciude |

D avidD
Exclude >

syzpgy
Guillaurne

K.atrina
Elviz
Jacques =l

Add Mew Participants To:

QK I Cancel | Lol |

Figure 4-14. You can assign Chat macros and filters
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Chat Window

&

Select Enable Chat macr os (Windows only).

Click Add to create a new macro.

A WD

Type the text that you want the macro button to represent.
5. Select anicon from the list provided.
6. Click OK.

The selected icon will now appear in the toolbar in the Chat window. When you are
typing Chat, you can click that macro button to insert the desired word or phrase. Note
that when you create the macro, you can choose to press ENTER at the end of the
macro text. Thiswill cause the macro text to automatically appear in the upper Chat
window pane when you click the macro button. If you do not press ENTER when
composing your Chat macro text, your text will appear in thelower Chat window pane
and you will need to press ENTER to send it.

Filtering Chat Text

There are times when you may not want your Chat window to show the messages of
all the conference participants. Fortunately, CU-SeeMeallowsyou filter out unwanted
text from your Chat window. Chat filters prevent you from seeing undesired Chat text
sent by others, but they do not prevent the Chat text that you send from being seen by
other participants. To send Chat to one sel ected participant only, see“Having aPrivate
Chat” on page 4-31.

To filter Chat text:

1. Click the Customize button on the Conference Room toolbar. Point to Chat
Extensions, then click. The Customize dialog box appears (with the Chat
Extensions tab displayed), as shown in Figure 4-14.

(You can a'so open thisdiaog box by clicking thefilter button ? onthetoolbar
in the Chat window.)

2. TheFilter Participants section of the dialog box shows alist of all participantsin
the current conference. Click on anamein that list. Then click Exclude.

* (Windows) The nameis now moved to the Exclude List.

* (Mac OS) That participant’s check box is now cleared.
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This means that Chat text from the selected person will not appear in your Chat
window. Y ou have excluded this person, or filtered this person from your Chat
window.

3. You can repest this process with other names to filter out more participants.

4. (Windows) Click on anamein the Exclude List. Then click Include. The name
is now moved back to the Include List. Chat text from the selected person will
appear in your Chat window once again.

(Mac OS) Click on the name of a participant who has been excluded from Chat.
Then click Include. The check box is selected again. Chat text from the selected
person will appear in your Chat window once again.

5. Using the option at the bottom of the dialog box, you can choose to have new
participantsin the conference either automatically allowed in (Include) or filtered
from (Exclude) your Chat window.

6. Click OK when you are done.

Having a Private Chat

Y ou can establish a private Chat with another participant. This meansthat evenin a
busy conference, you can have your Chat messages go to only one person whom you
select. Other participantswill not see what you typein the Chat window, however you
will continue to see Chat text from all the other participants.

To establish a private chat:
1. Onthe Conference menu, point to Chat to.

2. Point to the name of the person to whom you would liketo send private chat. Then
click.

3. Now, anything you type in the Chat window will be sent only to the selected
person.

4. To stop sending private chat to that person, go to the Conference menu, point to
Chat to.

5. Point to the name of the person to whom you have sent private messages. Then
click.

6. Now, you arereturned to public chat mode.
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Chat Window

When you are sending private Chat, you will see an indicator (e ) next to your name
in the Chat window, reminding you that you are sending private Chat. In addition, the
words Public Chat in the Chat window changeto Private Chat to <name>. Y ou can
send private Chat to only one person at atime. When another participant is sending
private Chat to you, you will also see an indicator (e ) next to that participant’s name
in the Chat window, letting you know that you are receiving private Chat from that
person.

To change to private Chat mode temporarily:

1. Inthe Chat window type the name of the person to whom you would like to send
private chat, followed by two angle brackets (>>), for example David>>.

2. Typeyour Chat message and press ENTER. That message will be private and will
be seen only by David and you, even though you are still in public Chat mode.

Y our next message will be public unless you use this procedure again to temporarily
change to private Chat mode. (If you had been involved in a private Chat with a
participant before this last private message, you will remain in that mode.)

To send a public message while in private Chat mode:

1. Typetwo angle brackets (>>) followed by your Chat message. Then press
ENTER.

2. Your message will be seen by everyone, even though you will till bein private
Chat mode. Y our next Chat message will bein private mode again.

Using Name Completion with Private Chat

Thisfeatureisthe quickest way to enter the name of aconference participant and send
that participant a private Chat message.

To complete a participant name automatically:

1. Typethe beginning letter or letters of the person’s name asit appearsin the
Participants List. For example, type Jfor Jonathan.

2. Pressthe TAB key. The nameis completed and the angle brackets (>>) are added
for you. That means when you type your Chat message and press ENTER, the
message will be sent only to that person.
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If there is another person in the conference with the same first letter or lettersin their
name (for example, Jonathan, Johanna, Joe), the system will default to the first name
on the Participants List. Press TAB multiple times to cycle through namesin the
Participants List that start with the |etter (or letters) you typed. In this example,
pressing TAB will cycle you through the “J’ names—Jonathan, Johanna and Joe—as
long as these names are in the Participants List.

When you use the name completion feature, private Chat istemporary; you will return
to public Chat mode immediately after sending your Chat message.

Resizing the Chat Window

Y ou can change the size of the Chat Window display areato makeit larger or smaller.
The video images will automatically adjust to fit the new size.

To resize the Chat window:

1. Move your mouse pointer over the splitter bar between the Participants List (or
Audio Controls) and the Chat window. The mouse pointer changes to a double
arrow.

2. Click and drag the splitter bar to the right or left to make the Chat window wider
or narrower.

3. Now, moveyour mouse pointer over the splitter bar between the Chat window and
the Video windows. The mouse pointer changes to a double arrow.

4. Click and drag the splitter bar up or down to make the Chat window taller or
shorter.
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Audio Modes

Audio Modes

Y our Windows computer must have a sound card installed if you want to send and
receive audio. If you have a full-duplex sound card, you can send and receive audio
simultaneously. All computers running Mac OS have full-duplex audio capabilities
built in. Thisis similar to atelephone which allows you to talk and hear at the same
time. If you have a half-duplex sound card in your Windows computer, you send and
receive audio, but you cannot do both at the sametime. Thisissimilar to a
walkie-talkie with which each person must take turns speaking.

With CU-SeeMe, you can transmit audio in your choice of two modes:
O HandsFree

Y ou transmit audio continuously. Everything you say is transmitted. If you have
afull-duplex sound card, CU-SeeMe selects Hands Free as your default audio
mode.

O PushToTak

Y ou only transmit audio when you push a button. If you have a half-duplex sound
card, CU-SeeMe selects Push To Talk as your default audio mode.

Y ou can switch between Hands Free and Push To Talk modeswhile you are connected
to a conference.

To switch between Hands Free and Push To Talk modes:

Configuration, then click. The Customize dialog box appears (with the

é 1. Click the Customize button on the Conference Room toolbar. Point to
Configuration tab displayed), as shown in Figure 4-15.
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Customize E

General I Wideo Lapout | Chat Style
Chat Extenzions I Hardware Configuration

— dudio

Maoving the slider toward quality will increase the quality of the audio
zent but will also increase the amount of data sent on the network.
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T

QK I Cancel | Apply

Figure 4-15. You can switch between Hands Free and Push To Talk modes

The upper portion of this dialog box is for audio settings. If the Hands Free

Operation check box is selected, CU-SeeMeisin Hands Free mode. If this check
box is not selected, CU-SeeMeisin Push To Talk mode. Click this check box to
switch between these modes.

If you select Hands Free Operation, you can select additional check box options
(Use Echo Reduction and High Mode). If you select Push To Talk, you can select
only the High Mode option. (Note that CU-SeeMe for Mac OS does not have the
High Mode option.)

Use Echo Reduction

High Mode (Windows only)

Click OK when you are done.

Chapter 4. Using the Conference Room

Thisis used to eliminate feedback which can occur if your microphoneis
located near your speakers. Select this check box to eliminate feedback if itis
aproblem.

For most users, this check box should not be selected. Selecting High Mode
resultsin alarger amount of redundant audio data transmitted. This may be
useful if you have noisy network lines, however it sends more data and

therefore uses more bandwidth.
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Audio Controls and Indicators

To learn about audio codecs, see “Choosing an Audio Codec” on page 5-7.

Audio Controls and Indicators

The audio controls and indicators consist of buttons, level indicators, and sliders, as
shown in Figure 4-16.

Squelch  Echo reduction

.l=—— Microphone volume level
Speaking to everyone

Your microphone
on/off switch

Your speaker G@
on/off switch

— Speaker volume level

Wu:u:udmatu:ur zpoke lazt

Figure 4-16. Audio controls and indicators are grouped together in the Conference Room

Turning Your Speakers Off and On

To turn your speaker off, click the speaker button. A red slash appears on the button,
indicating that this control isturned off. Click it again to turn it on.

Using Your Microphone in Hands Free Mode

If you arein Hands Free mode, click the Microphone button to turn it on or off. Note
that if you have a half-duplex sound card, and you select Hands Free mode and turn
your microphone on, your speaker will be turned off. Thisis because with a
half-duplex sound card, your microphone and speaker cannot be turned on at the same
time. Y ou will need to turn your microphone off in order to receive audio, or switch to
Push To Talk mode.

Using Your Microphone in Push To Talk Mode

If you arein Push To Talk mode, you must click and hold the microphone button in
order to transmit audio. Thisis the recommended mode if you have a half-duplex
sound card. To learn more about Hands Free and Push To Talk modes, see “Audio
Modes’ on page 4-34
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Adjusting Audio Levels

Use the volume dliders (shown in Figure 4-16) to raise and lower the level of sound
being sent from your microphone and being played through your speakers. Move the
slidersto theright to increase the levels and to the left to decrease the levels. The level
indicators show the level of sound being sent or received.

If you are in Hands Free mode, you will see ared triangle above the microphone level
indicator (see Figure 4-16). Thisis the Squelch control and it is only displayed when
you are in Hands Free mode. This control setsthe minimum level for sound to be sent
from your microphone when you are not receiving audio. Any sound below thislevel
will not be transmitted. Drag the Squelch control to the right to raise the minimum
level of sound that you will transmit. This can be useful when there is background
noise in your environment. Y ou can adjust the squelch level so that the background
noise is not transmitted.

If you are in Hands Free mode and you have Echo Reduction turned on, you will also
see agreen triangle above the microphone level indicator (see Figure 4-16). Thisisthe
Echo Reduction control. Echo Reduction is similar to Squelch control, except that it
workswhen you arereceiving audio. When you are receiving audio and sending audio
simultaneously, the Echo Reduction control can prevent your microphone from
sending sound that is coming from your speakers. Dragging the Echo Reduction
control to the right will raise the minimum level of sound that you will transmit. Echo
Reduction will also eliminate feedback, which can occur if your microphoneis placed
near your speakers.

When you are sending audio above the minimum level, then your audio is actually
being sent on the network and others can hear you. (Windows only: When your audio
is being transmitted, you will see an animated sound wave appear next to the
microphone level indicator, as shown in Figure 4-16.)

Sending audio and video simultaneously takes alarge amount of bandwidth. If you are
using alow bandwidth connection, such asamodem, you can freeze your local video
window to increase the amount of bandwidth available for sending audio.
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Status Bar

Status Bar

The Status Bar, located at the bottom of the Conference Room window, providestips
and information about your current status. For example, when you click and hold on a
toolbar button (Windows), or pause over atoolbar button (Mac OS), the Status Bar
presentsinformation about that button. When you pause your mouse pointer on amenu
command, the Status Bar presents information about that command. In addition, the
Status Bar tells you how long you have been connected to the current conference.
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Getting Information About a Participant

Y ou can get information about a participant in a conference. Oneway isto get a
participant’s Contact Card, which provides you with contact information about that
person. To learn how to do this, see “Exchanging Contact Cards’ on page 4-41. You
can also get information about a participant’ s software version, codecs, network
connection, and more in a separate floating window, called the Info window.

To display the Info window:
1. Do oneof thefollowing:

* (Windows) Using the right mouse button (right-click), select a video window
or aname in the Participants list.

e (Mac OS) Hold the CONTROL key and click on avideo window or anamein
the Participants list (CTRL-click).

2. A shortcut menu appears. Click I nfo.

3. Thelnfowindow is displayed, as shown in Figure 4-17. Click on any of the four
tabs in the Info window to see the following information about the selected
participant:

» Theversion of CU-SeeMe (or other H.323 videoconferencing client software)
» The audio and video codecs

» Whether the participant is sending video, looking at you, hearing you, and can
send audio

 Sending and receiving limitsallowed by the conference or network connection;
the actual send and receive data of the participant; the actual amount of data
you are receiving from the participant; the framerate you arereceiving; and the
packet loss percentage.
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Getting Information About a Participant

IP address of the
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Figure 4-17. You can get information about a participant’s software and network

4. Click on another video window or namein the ParticipantsList. The Info window
changes to display information about the new participant that you selected.

5. Click the close button to close the Info window.
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Exchanging Contact Cards

A Contact Card islike abusiness card or acard in arotary file. It is aconvenient way
to present and store information about a person or place, including contact
information. Some users of CU-SeeMe have created Contact Cards about themselves.
Y ou can get Contact Cards from these people electronically and add these cards to
your Phone Book. Thiswill enableyou to store contact information about these people
and call them directly from your Phone Book.

When you created a Personal Profile, you aso created a Profile Contact Card. Just as
you can get the Contact Cards of other users, they can get your Contact Card. If you
choose to videoconference on public conferences, your Profile Contact Card can be
seen and saved by anyone with CU-SeeMe; therefore, you should be careful what
information you choose to display on your Profile Contact Card. For example, if you
do not want strangers to have your phone number, then you should not list it on your
Contact Card.

To get a contact card from a participant:

1. Onthe Conference menu, point to Get Contact Card of. Thisdisplaysalist of
al the participants who have Contact Cards.

2. Point to the name of the participant you want to select, then click.

3. The Contact Card of the selected participant is now displayed in a separate
window, as shown in Figure 4-18.

Contact Card for Willy x|

williarn Finetres
LIE TR,

ClLek hers fsall

PPPIRLLLE e A s
HoME Page WRW WDING Com

Lo T

Figure 4-18. You can get a Contact Card from another CU-SeeMe user
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Exchanging Contact Cards

4. If you want to save the card, click Save. Thiswill save the Contact Card in your
Phone Book. Y ou can change the Nickname for the card (asit will appear in your
Contact Card list) and you can assign it to a Contact Group. For moreinformation
see “Contact Groups’ on page 3-13.

5. Click OK.

To find out how to create your own Contact Card that can be shared with others see
“Creating a Personal Profile” on page 3-25.
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Disconnecting From a Conference

<R

When you are ready to leave a conference, you can disconnect from the conferencein
one of 2 ways.

To disconnect from a conference:

O Onthe Conference menu, click Hang Up.
-or-

O Click the Hang Up button on the toolbar.

Thiswill disconnect you from the current conference. The Conference Room window
will close automatically and the Phone Book window will appear. Y ou can exit the
application or use the Phone Book to connect to other conferences. To learn more
about using the Phone Book, see Chapter 3.

To exit the application:

Do one of the following:
* (Windows) Choose Exit from the File menu in the Phone Book.

¢ (Mac OS) Choose Quit from the File menu.
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White Pine

Chapter 5
Configuring Your System

Y ou can use CU-SeeMe on any | P-based network or connection and on many types
of computers. The performance of your system will depend on many factors,
including the type of communication channel you are using (such as a modem, an
ISDN line, an Ethernet connection, and so on), the processing speed of your
computer, and the number of video windows simultaneously displayed on your
screen.

There are steps you can take to configure and customize your CU-SeeMe software
to get the best possible videoconference experience. Some of these steps are
explained in this chapter. Other information is available in online Help and in the
Frequently Asked Questions (FAQs) on the CU-SeeMe Web pages at
http://support.wpine.com/cuseeme.
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Choosing a Video Codec

Choosing a Video Codec

CU-SeeMe uses specia codec (COmpressor/DECcompressor) software to compress
and decompress your video (or audio) dataso that it can be sent more efficiently across
anetwork. Y ou can choose a video codec to best work with your network connection
and the type of computer you are using.

CU-SeeMe lets you choose from 3 video codecs:
0 White Pine M-JPEG

The Motion JPEG (or M-JPEG) codec offers high quality video on local area
networks (LANSs) and ISDN (or higher) network connections. It will also work
with modems, however lower quality settings (15% to 25%) are recommended. It
works with 8-bit, 16-bit, and 24-bit input (sometimes referred to as high color or
true color).

0 White Pine H.263

Thisisagood codec for general use on local and wide area networks (LANs and
WANSs), however it usesmore CPU power than the other codecs. Thiscodecisnot
recommended for modem usersasit will likely result in slow performance. White
Pine H.263 is a standards-based codec. Video sent with this codec can be seen by
users of CU-SeeMe Version 3.0 and higher. It can also be seen by users of other
videoconferencing software that meets the H.323 standard (such as Microsoft
NetMeeting or Intel Internet Video Phone) when you are connected to a group
conference hosted on a MeetingPoint Conference Server.

(Note: Macintosh computers with 68000 series processors cannot send or receive
video using the White Pine H.263 video codec.)

0 Cornell CU-SeeMe Gray

Thiscodec only sendsgrayscal eimages. The other video codecs et you send color
images (if you are using acolor camera). It isan excellent codec for modem users,
aswell as userson LANs and WANS. Y ou should choose this codec if your
camera or capture device does not support color.

Note: The White Pine Color codec, included in earlier versions of CU-SeeMe, has
been replaced with newer codecs that support standards-based conferencing. As a
result, you will not be able to see other users who are sending video using the White
Pine Color codec. However, if you had an earlier version of CU-SeeMe installed on
your computer, then you may still have the White Pine Color codec installed. Thiswill
enable you to see others who are sending with this codec.
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Previousversions of CU-SeeMedid not includeall of thesevideo codecs. People using
earlier versions of CU-SeeM e softwarewill not be ableto receive video sent with some
of the newer codecs. Table 5-1 explains who can see your video image, depending on

your choice of video codec.

Table 5-1. Determining who can see your video image

If you are using this
codec

These users will be able to see your video
image

White Pine M-JPEG

Any user with CU-SeeMe V3.0 or later or
Enhanced CU-SeeMe V2.1.1.

White Pine H.263

Any user with CU-SeeMe V3.0 or later (except
users with Macintosh computers with 68000
series processors).

Cornell CU-SeeMe Gray

Any user with any version of CU-SeeMe
(including Cornell freeware).

Thebest way to adjust avideo codec isusing the Test Setup featurein the Phone Book.
Thisalowsyou to see your local and remote video images simultaneously so you can
observe the effects of the changes you make. See“ Test Y our Setup” on page 5-12 for

more information. Y ou can also change video codec settings from the Conference

Room while in avideoconference.
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Choosing a Video Codec

5-4

To choose a video codec:

1. Click the Customize button on the Conference Room toolbar. Point to

Configuration, then click. The Customize dialog box appears (with the
Configuration tab displayed), as shown in Figure 5-1.

General I Wideo Lapout | Chat Style |
Chat Extensions I Hardware Canfiguration
— Audio

Maoving the slider toward quality will increase the quality of the audio
zent but will also increase the amount of data sent on the network.

Improve i i Improve
Metwork.  § | / , o Audio
Performance * Quality

DigiT alk (3.5 kbps]

¥ Hands Free Operation

™ Use Echo Reduction ™ High Maode
—Video
Changing the video codec affects the way video is zent over the
o hetwork.
Lodec:

|swhite Pine M~JPEG Codec 1.01 = Eonfigure...| About... |

¥ Use Only Recommended Codecs

T

QK I Cancel | Apply |

Figure 5-1. You can select a video codec to best fit your hardware and network setup

The video codec section is presented in the lower portion of the dialog box. Click
the arrow next to the video codec to display alist of available codecs. Click onthe
name of the desired codec.

Click Configure. Some codecs allow you to make additional configuration
settings and other codecs do not. For example, you cannot change configuration
settings for White Pine M-JPEG and White Pine H.263 codecs.

Y ou can use the video codec Quality dlider to adjust the clarity of the video image
you send. (It does not affect the video you see displayed on your screen.) The
Quality dlider is preset for each codec, but you can adjust it manually. While
increasing the Quality setting will improve the clarity of the picture you send, it
will al'so use more bandwitdth, which causes alonger time delay in your video
picture. Lowering the Quality setting will send afaster but lower quality video
image. Thiswill work better with alower bandwidth network connection, such as
amodem. See aso “Test Your Setup” on page 5-12.

Click OK when done.
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When Video Codecs Are Required by a Conference

When a MeetingPoint Conference Server is hosting a conference, it can require that
participants use specific video and/or audio codecs to join the conference. When you
try to join such a conference, CU-SeeMe will attempt to change its codecs
automatically to match the conference requirements. If the required video codec
cannot be found, you will join the conference as alurker (if the conference allows
lurkers). If therequired audio codec cannot befound, you will not be ableto send audio
for the duration of the conference.

When you leave the conference, you will need to switch back to your previous video
and audio codecs manually.

Recommended Settings for Each Video Codec

Thebest settingsfor each codec depend on anumber of factorsincluding your network
connection. While thereisno ideal setting for al conditions, recommendations are
described below. They areintended as a starting point, however you may find that you
need to adjust your settings from the recommended values.

Configuration refersto the Configure button shown in Figure 5-1. Quality refersto the
slider, also shown in Figure 5-1, and described on page 5-4.

Settings for White Pine M-JPEG

Configuration

There is nothing to configure for this codec.

Quality

For aLAN or WAN, the recommended quality setting is between 25 and 65%. The
settings are dependent on available bandwidth, your network connection, and the
processing speed of your computer’s CPU. For amodem, the recommended setting is
between 15 and 25%. See page 5-3 to learn how to adjust Quality.

Settings for White Pine H.263

Use this codec with 24-bit capture for best quality. This codec is not compatible with
al video capture cards. Macintosh computers with 68000 series processors cannot
send or receive White Pine H.263 video. If you have difficulty using this codec, switch
to White Pine M-JPEG.
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Choosing a Video Codec

Configuration

There is nothing to configure for this codec.

Quality

For aLAN or WAN, the recommended quality setting is between 20 and 40%. This
codec is not recommended for modem users asit will result in slow performance. See
page 5-4 to learn how to adjust Quality.

Settings for Cornell CU-SeeMe Gray

Configuration

Thereis nothing to configure for this codec.

Quality

For aLAN or WAN, the recommended quality setting is between 35 and 55%. For a
modem, the recommended setting is between 20 and 35%. See page 5-3 to learn how
to adjust Quality.

5-6 CU-SeeMe User Guide



Choosing an Audio Codec

CU-SeeMe uses codec software to efficiently send video and audio data across a

network, asexplainedin“ ChoosingaVideo Codec” on page5-2. Y our choice of codec
will depend on your computer environment, especially whether you are
communicating using amodem, aLAN, or an ISDN line. Use Table 5-2 to choose the
best audio codec for your computer.

Table 5-2. Audio codec recommendations

You can use this
audio codec

If you are using this means of

Modem

communication

ISDN

LAN

Voxware (2.4 Kbps)

[

[

G.723.1 elemedia™
(5.3 Kbps)

G.723.1 elemedia™
(6.4 Kbps)

DigiTalk (8.5 Kbps)

U
U
U

Delta-Mod (16 Kbps)

Intel® DVI (32 Kbps)

Oyo|ja] O] O

Oyoja) o) o0
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Choosing an Audio Codec

Aswith the video codecs, previous versions of CU-SeeMe did not include al of these
audio codecs. People using older versions of the software will not be able to receive
audio sent with some of the newer codecs. Table 5-3 explainswho can hear your audio,
depending on your choice of audio codec.

Table 5-3. Determining who can hear your audio

If you are using this These users will be able to hear your
codec audio
Voxware (2.4 Kbps) Any user with CU-SeeMe V3.0 or later (Windows

and Mac OS), and Enhanced CU-SeeMe V2.0 or
later (Windows 95 and NT users only)

G.723.1 elemedia Any user with CU-SeeMe V3.1 (except users with
(5.3 Kbps) Macintosh 68000 series processors)
G.723.1 elemedia Any user with CU-SeeMe V3.1 (except users with
(6.4 Kbps) Macintosh 68000 series processors)
DigiTalk (8.5 Kbps) Any user with CU-SeeMe V3.0 or later (Windows

and Mac OS), and Enhanced CU-SeeMe V2.0 or
later (Windows users only)

Delta-Mod (16 Kbps) Any user with any version of CU-SeeMe
(including Cornell freeware) and Enhanced
CU-SeeMe

Intel® DVI (32 Kbps) Any user with any version of CU-SeeMe
(including Cornell freeware) and Enhanced
CU-SeeMe

TheDigiTak, Voxware and G.723.1 audio codecs all work well with low bandwidths
and therefore are usable with most modems. Whileall of the audio codecs are designed
primarily for speech, the DigiTalk and G.723.1 (6.4 Kbps) codecs are able to transmit
both voice and music over modems, whereas the V oxware codec is able to send voice
only. Because of itslower bit rate, the G.723.1 codec is more appropriate for modem
users than the DigiTalk codec, and delivers better audio quality. Although the
Delta-Mod and Intel® DV codecs can both be heard by any CU-SeeMe user, they
require large amounts of bandwidth (Intel® DVI requires the most bandwidth), and
therefore may slow the overall performance of CU-SeeMe.

Sending audio and video simultaneously takes alarge amount of bandwidth. If you are
using alow bandwidth connection, such as amodem, you can freeze your local video
window to increase the amount of bandwidth available for sending audio.
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To freeze your local video:

(Windows)

1. Right-click onyour local video window. A shortcut menu appears.

2. Click Freeze Video. A 0 appears, indicating that your video is frozen.
3. Click it again when you want to return to sending full-motion video.

(Mac 0S)

1. Hold down the CONTROL key and click on your local video window
(CTRL-click). A shortcut menu appears.

2. Click Freeze Video. A » appears, indicating that your video is frozen.

3. Click it again when you want to return to sending full-motion video.

When Audio Codecs Are Required by a Conference

When a MeetingPoint Conference Server is hosting a conference, it can require that
participants use specific video and/or audio codecs to join the conference. When you
try to join such a conference, CU-SeeMe will attempt to change its codecs
automatically to match the conference requirements. If the required video codec
cannot be found, you will join the conference as alurker (if the conference allows
lurkers). If thereguired audio codec cannot be found, you will not be ableto send audio
for the duration of the conference.

When you leave the conference, you will need to switch back to your previous video
and audio codecs manually.
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Choosing an Audio Codec

To choose an audio codec:

Configuration, then click. The Customize dialog box appears (with the

1. Click the Customize button on the Conference Room toolbar. Point to
é Configuration tab displayed), as shown in Figure 5-2.

General I Wideo Lapout | Chat Style |
Chat Extenzions I Hardware Configuration

— dudio

Maoving the slider toward quality will increase the quality of the audio
zent but will also increase the amount of data sent on the network.

Improve i i Improve
Metwork.  § | / o Audio
Performance * Quality

DigiT alk (3.5 kbps]

¥ Hands Free Operation
™ Use Echo Reduction ™ High Maode

—Video

Changing the video codec affects the way video is zent over the
o hetwork.

Lodec:

|swhite Pine M~JPEG Codec 1.01 = Eonfigure...| About... |

¥ Use Only Recommended Codecs

T

QK I Cancel | Apply |

Figure 5-2. You can select an audio codec

2. Theaudio codec section is presented in the upper portion of the dialog box. Move
the audio codec slider to select an audio codec. Note that moving the slider to the
right improvesthe quality of the audio you send, but it al so decreases performance
of your computer. Moving the slider to the | eft increases performance but lowers
the quality. A lower quality audio codec will work better with alower bandwidth
network connection, such as amodem. See “ Choosing an Audio Codec” on page
5-7 for information to help you select an audio codec.

3. Select the Hands Free Operation check box if you have afull-duplex sound card.
If you select Hands Free, you will also see a check box labeled Use Echo
Reduction. When you are receiving audio and sending audio simultaneoudly, the
echo reduction control can prevent your microphone from sending sound that is
coming from your speakers. Thiswill eliminate feedback, which can occur if your
microphone is placed near your speakers. Select this check box to use echo
reduction. When echo reductionis selected, (and you have clicked OK or Apply),
you will see red and green triangle sliders above the microphone indicator in the
audio control section of the Conference Room Window. To learn how to usethese
diders and to learn more about Hands Free mode, see “Using Y our Microphone
in Hands Free Mode” on page 4-36.
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4. Select the High Mode check box (Windows only) if you are sending audio over a
high loss network. High mode adds more redundant audi o data acrossthe network
which helps your audio to be clearer even if some datais|ost. High mode also
causes your audio to be delayed several seconds.

5. Click OK when done.
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Test Your Setup

Test Your Setup
- The best way to adjust your video and audio settingsis using the Test Setup feature.
< J Tousethis, click the Test Setup button on the Phone Book toolbar. The Test Setup
== dialog box appears, as shown in Figure 5-3.

Test Setup [ %]

Test Video | Test Audio I

Local Remate

This is your remote video,
as others will see you

This is your local
video image

Configure. .. | About.... |

Lodec:
Improve '—J_ Improve
Perfformance 0 0 v 0 o 00 0T v Quality
75%
— Hardware

If your local video does not appear in the local video
‘= window above, you may need to configure your

%‘:ﬂtig:: IEomputerEyes.-"1D24 Diriver j
Farmat... | Source... | [isplaw.. | = | et Erey Tiatle:

QK I Cancel | Apply | Help |

Figure 5-3. Test Setup dialog box allows you to easily configure your video and audio

The Test Setup dialog box has two tabs, one for testing video and the other for testing
audio.
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Testing Video

The Test Video tab is shown in Figure 5-3. If you have avideo cameraand itis
connected and configured correctly, you will see two video images of yourself. The
oneontheleftisyour local video and the one on the right isyour remote video image.
The remote video image shows how others will see you in a conference. The remote
video image is hel pful because you can change codec settings and see how it affects
the video that you send.

To change video codec settings:

1

Click the arrow next to the video codec to display alist of available codecs. Click
on the name of the desired codec.

Click Configure. Some codecs allow you to make additional configuration
settings and other codecs do not. For example, you cannot change configuration
settings for White Pine M-JPEG and White Pine H.263 codecs.

The compression adjustment dlider is preset for each codec; however, you can
adjust it manually. Note that moving the slider to the right improvesthe quality of
the image you send, but it also decreases performance of your computer. Moving
the dlider to the | eft increases performance but lowers the quality. Lowering the
quality setting sends alower quality video image and sends less data. Therefore,
alower quality setting will work better with alower bandwidth network
connection, such as a modem.

Higher quality settings use more bandwidth and cause alonger time delay in your
video picture.Y ou can observe this by setting your quality to a high setting,
viewing both your local video and remote video simultaneously, and then waving
your hand in front of the video camera. The higher the quality setting, the more
time delay there is between when you move your hand and when the movement
is shown in the remote video window. Y ou will see that the quality setting does
not affect your local video window. Choose the lowest quality setting that
provides an acceptable remote video image. If you are using a modem, you will
need to use alower quality setting than if you are using LAN or WAN.

Click thearrow next to the capture deviceto display alist of video capture devices
installed in your computer. Click on the name of the desired device.

Do one of the following:
* (Windows) Click Format or Sour ce to make additional settings adjustments.
* (Mac OS) Click Configureto make additional settings adjustments.

Click OK when done.
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Test Your Setup

Testing Audio

If you have amicrophone, speaker, and sound card, you can test and adjust your audio
settings using the Test Setup feature.

To change audio settings:

(Windows)

1. Click the Test Setup button on the Phone Book toolbar. The Test Setup dialog
box appears. Click on the Test Audio tab. The Test Audio tab is shown in Figure
5-4.

Test Setup [ %]

TestVideo TestAudio |

[ istomnane r Audio codec slider

Improve ¢ i ¢ Improve
Performance . i Quality
DigiT alk (8.5 kbps]
Anpthing softer than the squelch level iz not sent.
Squelch: B ..., [ HandsFree
|
Yolume: '—J_

Becording Device: | SB16 Wave |n [220] j

— Speaker

Click Test to verify your current speaker volume. Move the
zlider to change vour speaker volume

Volume: " | e |

Playback Device: [5E16 wave Out [220] =

Select this if you have ———— Fuil Duplex
a full duplex sound card
QK I Cancel | Apply | Help |

Figure 5-4. (Windows) Test your audio setup

2. Movetheaudio codec dider to select an audio codec. Note that moving the dlider
to the right improves the quality of the audio you send, but it also decreases
performance of your computer. Moving the slider to the left increases
performance but lowers the quality. A lower quality audio codec will work better
with alower bandwidth network connection, such asamodem. See “ Choosing an
Audio Codec” on page 5-7 for information to help you select an audio codec.

5-14 CU-SeeMe User Guide



To change audio settings:
(Mac 0OS)

ggl.

Audio codec slider

Select the Hands Free check box if you have afull-duplex sound card. (To learn
more about Hands Free mode, see“ Using Y our Microphonein Hands Free Mode’
onpage4-36.) If you arein Hands Free mode, you will seethe Squelch dlider. The
Squel ch control is only displayed when you are in Hands Free mode. This control
sets the minimum level for sound to be sent from your microphone when you are
not receiving audio. Any sound below thislevel will not be transmitted. Drag the
Squelch slider to the right to raise the minimum level of sound that you will

transmit. This can be useful when thereis background noisein your environment.
Y ou can adjust the squelch level so that the background noise is not transmitted.

Speak into your microphone to test the volume level. Move the microphone
volume slider to raise or lower the level.

Click the arrow next to Recording Device to display alist of audio recording
devicesinstalled in your computer. Click on the name of the desired device.

Click Test to play a sound sample. Move the speaker volume dlider to raise or
lower the sound level.

Click the arrow next to Playback Deviceto display alist of audio playback
devicesinstalled in your computer. Click on the name of the desired device.

Click OK when done.

dn1as INoA 1591

Click the Test Setup button on the Phone Book toolbar. The Test Setup dialog
box appears. Click onthe Test Audio tab. The Test Audio tab isshown in Figure
5-5.

Test Setup

Test Yideo  Test Audia

— Microphone

T T 1 ' '

improre ¢ [ y improve

w FPetformance | . . . . ! Guality
Digitalk (2.5 kb/=)

E Hands Free {any hing softer than the slider level is not sentt

Squelch  © [
I

Volume: & [

Sound Input Devwice:  Built-in = | Source: _ Microphane - |

Click Test o verify your etwient speaker volume. Move the slider fo
change your speaker volumne.

i .

Sound Output Device:  Built-in = |

Figure 5-5. (Mac OS) Test your audio setup
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Test Your Setup

Move the audio codec slider to select an audio codec. Note that moving the slider
to the right improves the quality of the audio you send, but it also decreases
performance of your computer. Moving the slider to the left increases
performance but lowersthe quality. A lower quality audio codec will work better
with alower bandwidth network connection, such asamodem. See“Choosing an
Audio Codec” on page 5-7 for information to help you select an audio codec.

Select the Hands Free check box to seethe Squelch slider. (To learn more about
Hands Free mode, see “Using Y our Microphone in Hands Free Mode” on page
4-36.) The Squelch control is only displayed when you are in Hands Free mode.
This control sets the minimum level for sound to be sent from your microphone
when you are not receiving audio. Any sound below this level will not be
transmitted. Drag the Squelch slider to the right to raise the minimum level of
sound that you will transmit. This can be useful when there is background noise
in your environment. Y ou can adjust the squelch level so that the background
noise is not transmitted.

Speak into your microphone to test the volume level. Move the microphone
volume slider to raise or lower the level.

Click the arrow next to Recor ding Deviceto display alist of audio recording
devicesinstalled in your computer. Click on the name of the desired device.

Click the arrow next to Sour ceto display alist of audio sources. Click on the
name of the desired device.

Click Test to play a sound sample. Move the speaker volume slider to raise or
lower the sound level.

Click the arrow next to Playback Device to display alist of audio playback
devicesinstalled in your computer. Click on the name of the desired device.

Click OK when done.
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Setting Transmission and Reception Rates

For best performance you may need to adjust the rate at which you send and receive
video and audio signals. Table 5-4 shows CU-SeeMe's default minimum and
maximum transmission and reception rates for a range of networking devices.

Table 5-4. Default transmission and reception rates

Minimum Maximum Minimum Maximum
When using Send Send Receive Receive
(Kbps) (Kbps) (Kbps) (Kbps)

Modem 28.8 Kbps 1 18 1 18
Modem 33.6 Kbps 1 18 1 18
Modem 56 Kbps 5 40 5 40
ISDN 64 Kbps 5 40 5 40
ISDN 128 Kbps 10 80 10 80
LAN 256 Kbps 10 80 10 150
LANT1 and more 10 80 10 300

Y ou can increase transmission rates for better performance, however, there are limits.
For example, if you are transmitting with a 28.8 Kbps modem, you will be limited to
amaximum transmission rate of 28 Kbps.

The reception options set the rate at which you receive audio and video. Limiting
reception may beimportant if you have a 28.8 Kbps modem connection. If you are set
to receive 30 Kbps for example, you may not be able to send any signals out because
you will beusing al of your available bandwidth to receive signals.

When you join agroup conference, you may find that some conferenceswill not admit
you until you make adjustments in your transmission and receptions rates. Other
conferences may ask you if you would like to have your rates adjusted automatically.
Y ou can choose this automatic adjustment option if it is presented to you.

Chapter 5. Configuring Your System 5-17

sajey uondaday pue uoissiwsuel| Bumas



Setting Transmission and Reception Rates

Setting Rates for a Contact Card

Y ou can set minimum and maximum transmission and reception rates for each entry
in your Phone Book using the Contact Card Editor. Thisis useful because some
conference servers require lower transmission rates than others and you can preset
your rates for each conference server individually by editing the Contact Card in the

Phone Book.

To set transmission and reception rates using the Contact Card Editor:

1. Select the entry in the Contact Card list by clicking on a Contact Card or aname
in thelist of Contact Cards.

2. Onthe Edit menu, click Contact Card Properties. The Contact Card Editor

appears. Select the Network tab as shown in Figure 5-6.

Contact Card Editor Ea
] Card Perzonal Infa | Card Buzinesz Info | Card Layout |
Select this to use the General | Cornection Metwork
settings defined in your
Personal Profile | - MNetwark Usage
) = " lse Profile Settings
Select this to -
modify settings -
Send Send Recy. Recy.
. <« ISD 3y LS4 ISDD 3>
Enter maximum Less _| : More Less _I . More
transmission rate
(Kbps) — Conference
Select this to send - ¥ Send'ides
video when connected
— Compatibility
Select this to use the —— » ,
minimum reception IV Enfarce Mirimurmn Fates Settings
and tran5m|55|0n rates Mirirurn B eception Fate [in Kbps): I'I 0
you define
Minimum Transmizzion Rate (in Kbps): I'I 0
Ok, I Cancel | Help |

Enter maximum
reception rate
(Kbps)

Enter minimum
reception rate
(Kbps)

Enter minimum
transmission rate
(Kbps)

Figure 5-6. The Contact Card Editor lets you modify transmission and reception rates

3. Change the maximum transmission and reception rates by clicking on the arrows
or typing anew rate in the text boxes (see Figure 5-6).

4. Change the minimum transmission and reception rates by typing in the text boxes
(see Figure 5-6).
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5. When you have completed all your edits to the Contact Card, click OK. These
changes will be saved in your Contact Card. Any time you connect to the person
or place on that Contact Card, you will use these new settings.

Setting Rates While In a Conference

In addition to setting rates for each Contact Card, you can also change your maximum
transmission and reception rateswhile you arein aconference. Thischange will affect
the current connection only.

To set transmission and reception rates in a conference:

(Windows)

&

1. Click the Customize button on the Conference Room toolbar. Point to
Har dwar e, then click. The Customize dial og box appears (with the Hardware tab
displayed), as shown in Figure 5-7.

Customize
Select this to use the General I Wideo Lapout | Chat Style
settings deﬂned in your Chat E stensions Hardware Configuratiarn
Personal Profile | ~ Network
T 0 U= Brafile Settings
Select this to — ] .
modify settings
Send Send Recy. Recy. Ent i
. << IBD b3S <« ISDD > nter maximum
Enter maximum (e <] i N o ] L Mere reception rate
EI;(&SSI’T)]ISSIOH rate —Audio Devices (Kbps)
ps : .
Recording Device: ISB‘I B'Wave In [220] j
Flayback Device: | 5816 Wave Dut [220] =l
Yideo Capture Device
Capture IComputerEyesﬂ 024 Driver j
= (et GreyiTiatle [ieplEm.. Eorrnat... | Source... |
Ok I Cancel | Lppl |

Figure 5-7. (Windows) You can change transmission and reception rates while in a conference
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Setting Transmission and Reception Rates

Change the maximum transmission and reception rates by clicking on the arrows
or typing anew rate in the text boxes (see Figure 5-7). Note that you cannot
change the minimum rates while you are connected. To change minimum rates,
you must hang up from the conference and change the rates using the Contact
Card Editor. For more information, see “ To set transmission and reception rates
using the Contact Card Editor:” on page 5-18.

When you have completed your changes, click OK.

To set transmission and reception rates in a conference:
(Mac OS)

Har dwar e, then click. The Customize dialog box appears (with the Hardware tab

é 1. Click the Customize button on the Conference Room toolbar. Point to

Select this to use the
settings defined in your
Personal Profile |

displayed), as shown in Figure 5-7.

Customize

General I Wideo Layout I Chat Style I Chat Extensions Hardware Configuration

— Network Usage

Select this to

O Uze Profile Settings

modify settings

Enter maximum

transmission rate —__|

@) Use Custorn Settings

Send I 20 Send Receive I 300 Receive
less | more less 1 more

— Audio Devices

Enter maximum
reception rate
(Kbps)

Input Dewice:  Built-in VI
Output Dewice :  Built-in vl

— Wideo Capture Device

Capture Device:  Connectix Color QuickCarm - I

Source: _ Microphone - I

Figure 5-8. (Mac OS) You can change transmission and reception rates while in a conference

Change the maximum transmission and reception rates by clicking on the arrows
or typing anew rate in the text boxes (see Figure 5-8). Note that you cannot
change the minimum rates while you are connected. To change minimum rates,
you must hang up from the conference and change the rates using the Contact
Card Editor. For more information, see “To set transmission and reception rates
using the Contact Card Editor:” on page 5-18.

When you have completed your changes, click OK.

5-20 CU-SeeMe User Guide



Select this to
modify settings

Enter maximum
transmission rate to use

Setting Rates While Manu

ally Dialing

Y ou can set both new and minimum transmission and reception rates for a specific
connection, for example, when you are manually dialing someone.

To set transmission and reception rates while manually dialing:

1. ClicktheManual Dial button onthe Phone Book toolbar. TheManual Dial dialog

box appears.

2. Select the Network tab as shown in Figure 5-9.

M anual Dial

Generall Conference  Metwark, |

— Metwork usage

Select this to use the
settings defined in your
Personal Profile

& |ze profile settings

" {[ize custom settings

when calling (Kbps)

Select this to use the
minimum reception
and transmission rates
you define

Enter a minimum

Recw.
Less

1
T

——  Enforce minimum rates setiings

reception rate
(Kbps)

tin reception; I'I 1] Mir trangmizsion; I'I 0
| L

tdanual Dial I

Cahcel | Help

Enter maximum recep-
tion rate to use when
calling (Kbps)

Enter a minimum
transmission rate
(Kbps)

Figure 5-9. You can modify transmission and reception rates for a call

3. IftheUseprofilesettingsoptionisselected, your call will usethe settings defined
inyour Personal Profile. (See” Setting Ratesfor aPersonal Profile” on page5-22.)
If you want to use different settings for this call, select the Use custom settings
option. Enter the maximum transmission and reception rates you want to use for
the call by clicking the arrows or typing a new rate in the text boxes (see Figure

5-9).

4, To set different minimum transmission and reception rates for the call, select the
Enforce minimum rates settings check box, then enter the new minimum rates.

5. When you have completed your changes, click Manual Dial or select another tab

to make additional changes.
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Setting Transmission and Reception Rates

Setting Rates for a Personal Profile

Y ou can set maximum transmission and reception rates for each Personal Profile that
is stored in your Phone Book. For example, if you have a portable computer that uses
aLAN from your office and a modem from your home, you would want to have two
different sets of maximum transmission and reception rates, one for each location. In
thisinstance, you would define one Personal Profile to use from your office and

another to use from your home. Each profile would have rates defined for the specific
network type.

To set transmission and reception rates for a Personal Profile:

3. Select aProfile from thelist. Then click Edit.

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then
click.

2. TheCU-SeeMe Call Optionsdialog box appears (with the Profiles tab displayed).

4. The Personal Profile Editor appears. Select the Hardware tab, as shown in
Figure 5-10.

Perzonal Profile Editor

Card Personal Info I Card Business Info

General I Security

Card Layout |
Hardware

— Metwork Configuration

LA T1 And More

Click here to display
a drop-down list from
which you can select your
type of network

Customize... I|

Click here to
display the
Customize Network

—Wideo Hardware

Capture Device :

ComputerEyes/1024 Driver

dialog box

— &udio Hardware

Recording Device

[SB16 wave In [220]

Playback Device :

[SB16 wave Out[220]

[ o ]

Cancel |

Help |

Figure 5-10. Select a network configuration in the Personal Profile Editor
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5.

Inthe Network Configuration section, use the drop-down list to sel ect the network
type that most closely matches yours. Then click Customize.

6. The Customize Network dialog box appears, as shown in Figure 5-11.

Enter maximum
transmission rate
(Kbps)

Customize Metwork x|

Send
Less

o can modify the marimum rates at which pou send and receive data.
- Enter maximum

I Send Recy. I Recy.
8? a4 Mare Less ilSDD > Mare
I ——
reception rate

(]9 | Cancel | (Kbps)

Figure 5-11. You can modify maximum transmission and reception rates

Change the maximum transmission and reception rates by clicking on the arrows
or typing anew rate in the text boxes (see Figure 5-11). Note that you cannot
change the minimum rates for a Personal Profile. To change minimum rates, you
must change the rates using the Contact Card Editor. For more information, see
“To set transmission and reception rates using the Contact Card Editor:” on page
5-18.

Click OK.

When you have completed all your edits to the Personal Profile, click OK.

10. Then click OK again to close the CU-SeeMe Call Options dialog box.
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Registering With an Online Directory Service

Registering With an Online Directory Service

5-24

A directory serviceisaWeb-based listing that allows users of CU-SeeMeto find each
other, seeif they are online, and connect directly to them.

Each user on the Internet has an Internet Protocol (1P) address that is a unique
identifier. Many Internet Service Providers and online services assign | P address
dynamically; that is, you get a new | P address each time you connect to the Internet.
Thisislike changing your telephone number each time you place acall, and it has
made it difficult in the past for online users to find and connect to each other. The
Web-based directory service solves this problem by automatically registering your
current I1P address as soon as you connect to the Internet, making it easy for other
people to locate you.

When you set up CU-SeeMe on your computer, you were given the opportunity to
register with Four11 directory service (see “Using the Setup Assistant” on page 2-2).
If you chose this option, you are now listed in this Web-based directory and other
CU-SeeMe users will be ableto locate you online. If you did not choose this
registration option during set up, you can still register at any time.

To register with Fourl1 directory service:

0 (Windows) From the Windows desktop, click Start, point to Programs, point to
CU-SeeM g, then click Four 11 Registration. Y our Web browser will open and
you will be connected to the Fourll CU-SeeMe registration page.

O (Mac OS) Open the Four11 folder in your CU-SeeM e 3.1 folder. Then
double-click Four 11 Connect Client. Y our Web browser will open and you will
be connected to the Four11l CU-SeeMe registration page.

-0r -

O Using aWeb browser, go to the Fourll Web page at http://www.fourll.com.
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Configuring a Web Page to Launch CU-SeeMe

CU-SeeMe can belaunched directly from aWeb page displayed inaWeb browser. By
setting up CU-SeeMeto launch from aWeb page, you can provide accessto additional
information that wouldn’t be feasible if you were to use CU-SeeMe by itself. For
example, you may want to set up acamerato display aclassroom. Although thiscould
be done using CU-SeeMe by itself, you could provide additional materialsto viewers,
such astext and graphics, by placing this material on a Web page.

Y ou can also create a Web page with alink to launch CU-SeeMe as a convenience to
readers of your Web page. For example, if you host a conference, you can use aWeb
page to publicize the conference and allow users to join the conference directly from
the Web page.

To launch CU-SeeMe from a Web page, you must configure your browser to
automatically launch CU-SeeMe when prompted by a.cu file.

In addition, the Web administrator must set up the Web page and Web server as
follows:

O Create aWeb pagethat linksto a.cu file (afile type used to launch CU-SeeMe
and connect to a conference).

O Ensurethat the Web server recognizes CU-SeeMe' s MIME type. Use your Web
server’ s facilities to configure the mapping between the CU-SeeMe MIME type
and the .cu file extension:

M ME type: application/x-cuseene

Ext ensi on: .cu

Creating the File that Launches a Conference

If you want other CU-SeeMe users to be able to launch CU-SeeMe and join a
conference directly from your Web page, you need to create a\Web page with alink to
a.cufile. This.cu file defines the | P address and Conference ID of the conference
server to which you want users to connect. Place thisfile, with the other html files, on
the Web server.

Each entry in your Phone Book can become a.cufile. You can create a.cu filefrom a
Phone Book entry by exporting the Contact Card associated with that entry.
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Configuring a Web Page to Launch CU-SeeMe

To export a Phone Book entry as a .cu file:
1. Select anentry inthe List of Contact Cards.

2. Onthe File menu, point to Export. Then point to Selected Contact Card and
click.

3. A dialog box appearswhere you can define the file name and location for the new
.cufile. Savethefileasa.cu filetype and click OK.

Y ou can also drag an entry from the List of Contact Cardsand drop it on your desktop
(or any folder). This entry automatically becomes a standalone .cu file. For example,
if you drag-and-drop the entry for White Pine Cafe from your Phone Book to your
desktop, it creates afile called White Pine Cafe.cu. This.cufileretains all the
connection properties of the original Phone Book entry, such as | P address, network
connections, and so on.

See“Adding Entriesin the Phone Book” on page 3-20 for information on creating new
Phone Book entries.

(Windows) If you are a Windows user, you can create a blank .cu file, and then edit
its properties as follows:

1. FromtheWindowsdesktop, click Start, point to Programs, point to Accessories,
then click Notepad. A blank Notepad file appears.

2. Choose File, then Save As. Enter afile name of your choice, followed by a.cu
extension, for example, whitepine.cu. Click Save then quit Notepad.

3. Right-click on thefile'sicon to display the shortcut menu, then choose
Properties. The Properties dialog box appears. (This dialog box works similar to
the Contact Card Properties dialog box. See “Editing a Contact Card” on page
3-23)

4. Enter the appropriate information in each of the tabs, for example:

» ThelP address - the address of the conference server or CU-SeeMe host to
which you would like to connect using CU-SeeMe

» Conference ID - the conference ID used by the conference server
If youwant usersto connect directly to aspecific conference on your server and
bypass the dialog box that lists all available Conference Rooms, you need to
specify the conference ID number preceded by 0 (zero). For example, if you
want users to connect to Conference 2, specify the Conference ID number as
02.

5. Click OK when you are done.
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Configuring Your Browser to Launch CU-SeeMe

Y ou can configure the Web browser installed on your computer to launch CU-SeeMe
when it encountersa.cu filelinked from aWeb page. There are many versions of Web
browsersavailablefor useand it isbeyond the scope of this User Guideto explain how
to configure every Web browser. Consult the documentation or online Help for your
Web browser to learn how to configure your browser.

Asageneral guideline, follow these steps:

1. Locate the dialog box to add new file typesin your browser, typically in a
preferences dialog box. For example:

* Netscape Navigator ™ 3.0 - Choose General Preferences from the Options
menu, then select Helpers. Now click on Create New Type.

* Netscape Navigator 4.0 - Choose Pr efer ences from the Edit menu, then
Navigator (under Category), then select Applications.

* Internet Explorer 3.0 - Choose Options from the View menu, then the
Programs tab, then File Types, and finally New Type.

Specify the mime type (if applicable): application
Specify the mime subtype (if applicable): x-cu-seeme

Specify the file extension or suffix: .cu

a c w DN

Specify CU-SeeM e asthe application. Y ou can use the Browse or Choose option
to search for the CU-SeeMe program.

(Windows) Make sure CU-SeeMeisin your path, or specify the full pathname of
the cuseeme executable.

6. Set the action to launch the application.

Additional information is available in the Frequently Asked Questions (FAQ) section
of White Pine’s Technical Support Web pages at http://support.wpine.com/cuseeme.
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White Pine Appendix A
Technical Support

This Appendix contains information on how to contact White Pine for technical
support and sales information.
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Getting Technical Support

Getting Technical Support

White Pine Software provides 90 days of free telephone support to all registered users
after purchasing and registering the product. Only purchased copies of the product can
be registered, meaning that you can not register any of the freeware versions of
CU-SeeMe available through Cornell University.

Registering CU-SeeMe

Y ou must register with White Pine in order to receive technical support. If you
purchased CU-SeeMe from our online Storefront, you are automatically registered.
Other users can register in any of the following ways:

O Completetheregistration card included with CU-SeeMe and mail it to White Pine.

0 FromtheHelp menuin CU-SeeMe, click Registration. This opensaWeb browser
and displays the White Pine Software Product Registration Web page, allowing
you to register your copy of CU-SeeMe online.

0 Using any Web browser, go to the CU-SeeMe Web page at
http://www.cuseeme.com and select Register CU-SeeM e. Fill out theonlineform
to register your copy of CU-SeeMe.

Support on the World Wide Web

The White Pine Web pages offer avariety of information about the company, products,
and demo versions of released software, in addition to technical support.

The Technical Support pages offer online registration, technical support through an
interactive form, and alist of Frequently Asked Questions about using CU-SeeMe.

Y ou can reach the White Pine Software technical support Web page at
http://support.wpine.com/cuseeme.
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Before You Contact Technical Support

White Pine Software provides technical support to registered users. Return your user
registration card promptly or register CU-SeeMe using online registration (see
“Registering CU-SeeMe’ on page A-2). Product registration guarantees you new
product notification and product upgrades.

To get your problems solved as quickly as possible, the technical support staff requires
as much pertinent information as possible. If you can supply us with thisinformation
at thetime of your call, we can understand and resolve your problem much faster. Y ou
should have thisinformation ready and be at your computer when you call for technical
support and be ready to reproduce the problem whiletalking to atechnical support staff
member.

Please fill out the following information before calling:

Serial #:

Product:

Version:

Date Purchased:

Original Purchaser:
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Before You Contact Technical Support

Your Computer Configuration
Make and Model:

Microsoft Windows or Mac OS Version:

Disk Space:

Memory (RAM):

Video Card Manufacturer and Model:

Video Capture Card Manufacturer and Model:

Sound Card Manufacturer and Model:

Camera Manufacturer and Model:
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Communications Configuration

Internet Connection:
Ethernet: ISDN: Modem:

Modem Manufacturer and Mode!:

Model of your Ethernet board:

Network drivers and other communication software installed on your system:

0O TCP/IP Driver:

O Dial-up PPP (if using a modem):

O Internet Service Provider (ISP):

Appendix A. Technical Support
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Contacting White Pine Software

Contacting White Pine Software

While our Technical Support staff often takes callsimmediately, there are timeswhen
arepresentative may be unavailable. If your problem can not be resolved during your
initial call, the issue will be discussed with our product specialists and engineering
staff, and a representative will contact you.

Technical Support

Online form: http://www.cuseeme.com/cu-support.html
Phone: 603-594-2804  8:00 am - 8:00 pm EST

Corporate Headquarters

White Pine Software, Inc.

542 Amherst Street

Nashua, NH 03063 USA
Phone:  603-886-9050

Fax: 603-886-9051

E-mail: info@wpine.com
WWW:  http://www.wpine.com

European Headquarters

White Pine Software, SA

9551, route de Saint Laurent du Var
06610 La Gaude France

Phone: +33.4.93.59.43.43

Fax: +33.4.93.24.76.06

E-mail: euro-info@whitepine.fr
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Sales Hot Line

For moreinformation about all White Pine Software products, please contact the White
Pine Software sales department. Demos and product information are also available on

the World Wide Web.

U.S. E-Mail:  info@wpine.com
U.S. Phone: 1-800-241-PINE (7463)

Europe E-Mail: euro-info@whitepine.fr
Europe Phone:  +33.4.93.59.43.43

WWW: http://lwww.cuseeme.com

Appendix A. Technical Support
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White Pine

Glossary

Bandwidth

The capacity to send information on anetwork. It isusually measured in
bits per second (bps) or kilobits per second (Kbps).

Browser
A software program that allows a user to access resources on the I nternet.
Chat Macro

Shortcut buttons that allow you to automate typing of words, phrases, or
symbols that you use often.

Chat Window

A feature of CU-SeeMe that allows users to converse using text
messages. The Chat window is a component of the CU-SeeMe
Conference Room window.

Codec

COmpressor/DECompressor; Hardware or software that compressesand
decompresses audio and video data. CU-SeeM e uses software codecs.

ConferencelD

A number between 1 and 32768 that is provided to attendees of aprivate
conference session. This ID number is needed for some conferences.

Conference Room

The CU-SeeMe window in which videoconferencing takes place. It is
like avirtual meeting room where you can see and talk to others.
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Glossary

Conference Server

Software, such as MeetingPoint Conference Server, that delivers multimedia
group interaction across |P networks. A conference server isthe server
program in a client/server videoconferencing solution. (CU-SeeMeisthe
client program.)

Contact Card

A convenient tool for storing information about a person or place. It islike a
business card or acard in arotary file. Contact Cards are displayed in the
CU-SeeMe Phone Book Window.

Contact Group

A collection of Contact Cards.
CU-SeeMe

Videoconferencing software for desktop computers.
CU-SeeM e Name

Y our user name that appears when you conference with others. Y our
CU-SeeMe name and the CU-SeeM e names of other participants appear in
the Participants List in the Conference Room window.

Cybercast Conference
The transmission of the same data to a selected group of destinations.
Full-Duplex

Allows both partiesto send and receive audio at the sametime. This affects
the receiver only.

Half-Duplex

Allows only one person to talk at atime. This affects the receiver only.
I nter net

A global network that uses the TCP/IP protocol.
Internet Service Provider

A company that provides a connection to the Internet for afee.
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IP Address

The unique numeric address for every computer that is connected to the
Internet. It hasfour sections separated by adot, for example, 100.1.1.1. AnIP
address can be dynamic and is often provided by Internet service providers.

P Name
The unique name for every computer that is connected to the Internet.
| SDN

Integrated Services Digital Network; A high bandwidth network used to
move large amounts of data over phone lines.

Kbps

An abbreviation meaning kilobits per second, used for measuring bandwidth.
Listener

A CU-SeeMe feature that alerts you to an incoming call.
Local Area Network (LAN)

A network made up of two or more computers connected together. They are
usually within the same building or within avery short distance (amile or
less) to each other.

Local Video

The window containing your video image on your computer screen. This
video image can be sent to other people using CU-SeeMe.

Lurker
A CU-SeeMe conference participant who is not sending a video image.
M eetingPoint Conference Server

MeetingPoint is White Pine’' s H.323 standards-based videoconferencing
server software.

M essage of the Day (MOTD)

A dialog box that appears when users connect to a conference. It can provide
information about the conference, current and upcoming cybercasts, etc.
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Glossary

Multicast

The ability to send one stream of video data and one stream of audio dataover
anetwork, and many users can simultaneously connect to and receive these
streams of data without the use of additional software.

Parental Control

A security feature that allows you to put restrictions on the CU-SeeMe calls
that are made from your computer and the calls accepted by your computer.

ParticipantsList

A component of the Conference Room window that lists the people currently
connected to a conference.

Per sonal Profile

A Personal Profile identifies you to other people on the network. It includes
your CU-SeeMe name, contact information, Parental Control options, and
more.

Phone Book

A CU-SeeMe feature that works like a personal directory where you can list
anyone you might want to call. Y ou use the Phone Book to initiate a
CU-SeeMe videoconference call.

Point-to-Point Conference
A direct connection between two CU-SeeMe users.
PPP

Point-to-Point Protocol. A protocol that allows a computer to make a TCP/IP
connection using atelephone line and a modem.

Profile Contact Card

When you create a Personal Profile, you also create a Profile Contact Card. It
islike abusiness card that you can exchange with others electronically.

Protocol
Standards that allow programs on different computers to communicate.
Remote Video

The window that contains the video sent by another participant in a
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conference.

Router

A computer system or software package that connects two or more networks.
Routerslook at the destination addresses of the | P packets and forward them
to the correct address.

Sender
A CU-SeeMe conference participant who is sending a video image.

TCPIIP

Transmission Control Protocol/Internet Protocol. The protocol that defines
the Internet.

Time-to-Live(TTL)

A value used by routers that is decremented as it is passed from router to
router.

URL

Uniform Resource Locator. An “address’ used to locate information on the
Internet.

WhitePineBoard

A feature of CU-SeeMe for Windows that all ows usersto view, create and/or
share the same document at the same time.

Wide Area Network (WAN)
A large network made of connected LANS.
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answering an incoming call 3-38
Assistants 1-7
CU-SeeMe Setup Assistant 2-2
Multicast Conference Assistant 3-46
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adjusting levels 4-37
codec 4-39
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microphone 4-36
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using echo reduction 4-35, 5-10
using high mode 4-35, 5-11
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broadcast
see cybercast conference
browser
configuring to launch CU-SeeMe 5-27
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Call menu
Phone Book 3-7, 4-6
Call Options button 3-11
caling 3-16
Chat
customizing 4-26
enabling URL highlighting 4-27
enabling URL launching 4-27

filtering text from selected participants 4-30

how to exchange messages 4-26
private Chat 4-31
resizing Chat window 4-33
toolbar 4-26
using macros 4-29
window 2-18, 4-26
Close All command 2-15
codec
audio 4-39
choosing 5-7
compatibility 5-8
Delta-Mod 5-7
DigiTak 5-7
G.723.15-7
Intel DVI 5-7
Voxware 5-7
definition 5-2
video 4-39, 5-2
choosing 5-4
compatibility 5-3
configuring 5-4, 5-13
Cornell CU-SeeMe Gray 5-2
recommended settings 5-5
White Pine H.263 5-2
White Pine M-JPEG 5-2
Conference Control Center 4-18
Conference menu
Conference Room 4-7
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Conference Room
components 4-2
menu 4-3
Conference 4-7
Edit 4-5
File4-4
Help 4-9
Window 4-8
toolbar 4-10
Customize 4-10
Hang Up 4-11
Phone Book 4-10
Speak To 4-10
Video 4-10
WhiteBoard 4-10
window 2-12, 4-2
Configuring Web Page 5-25
Contact 2-7
Contact Card
Assistant 3-20
creating 3-20
creating in Setup Assistant 2-7
definition 3-12
deleting 3-23
editing 3-23
Editor 3-23, 5-18
exchanging 4-41
New Contact Card command 3-20, 3-21
Profile Contact Card 3-25
selected card 3-12
Setting transmission and reception rates 5-18
Contact Group
definition 3-13
deleting 3-14
editing 3-14
Cornell CU-SeeMe Gray codec 5-2
Creating 5-25
CU-SeeMe Setup Assistant 2-2
Customize button 4-10
cybercast conference 1-10, 3-45
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Delta-Mod
see codec



DigiTalk codec 5-7
directory services 2-4, 3-19
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registering 5-24
disconnect
see Hang Up button
E
echo reduction 4-35, 4-37, 5-10
Edit menu
Conference Room 4-5
Phone Book 3-5
F
FAQ
see Frequently Asked Questions
File menu
Conference Room 4-4
Phone Book 3-4, 3-9
filetype
.csv 3-22
.cu 3-22,5-25
.cu file 5-25
Axt 3-22
wav 3-34
Four-11

see directory services
freeze video 5-9
Frequently Asked Questions 5-1
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G.723.15-7

get Contact Card 4-41
grayscale video codec 5-2
group conference 1-9

H

H.263
see codec
Hang Up button 2-20, 4-11, 4-43
Help 1-2
Help menu
Conference Room 4-9
Phone Book 3-10

high mode 4-35, 5-11
I

import
Assistant 3-22
Info for... window 4-39
Intel DVI codec 5-7
Internet Protocol address
see | P address
Internet Service Provider
connecting with CU-SeeMe 2-10
IP address 1-9, 2-11
ISP
see Internet Service Provider

L

layout
changing video windows 4-23
using custom background colors 4-24
Listener
answering an incoming call 3-38
changing settings 3-32
creating active filters 3-36
definition 3-30
enabling 3-30
modifying the notification method 3-34
modifying the response 3-35
local video 2-13
lurker
definition 2-14, 4-12
switching to a sender 2-16, 4-21
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menu
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creating 3-46
creator 3-45
cybercast 3-45
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enabling 3-45
group multicast conference 3-45
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N

New Card button 3-11, 3-20
New Contact Card command 3-20, 3-21
nickname.ini file 3-22

0

one-way conference
see cybercast conference
online Help 1-2

P

Parental Control 3-14
configuring 3-39
enabling 3-42
using passwords 3-42

participant
getting information about 4-39

Participants List 2-12
changing views 4-12
definition 4-12
detailed list view 4-14
large icon view 4-17
list view 4-14
moving 4-17
resizing 4-18
small icon view 4-16
sorting 4-15

performance 5-1

Personal Profile
Assistant 3-26
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definition 3-1, 3-25
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Help 3-10
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toolbar 3-11
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window 3-1
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point-to-point conference 1-8
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Chat window 4-33
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selected card 3-12
Send Video command 2-16, 2-17, 4-22
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definition 2-14, 4-12

switching to alurker 2-16, 4-21
Setup Assistant 2-2
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sound card

full-duplex 4-34

half-duplex 4-34
Speak To button 4-10
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adjusting volume 4-37

turning off and on 4-36
Speed Dial button 3-11, 3-16
sguelch control 4-37, 5-15, 5-16
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Conference Room 4-38

Phone Book 3-15
system requirements 1-4
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technical support
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capture card 1-4
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seeing 2-14, 2-16, 4-19
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White Pine Software, Inc. End User License Agreement

THIS IS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF
THIS AGREEMENT.

1. White Pine grants to you a non-exclusive, non-sublicensable, license to use this Software in binary executable form.

This White Pine Software, Inc. (“White Pine”) End User License Agreement accompanies a White Pine software product
and related explanatory written materials (“Software”). The term “Software” shall also include any upgrades, modified
versions or updates of the Software licensed to you by White Pine.

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR DOCUMENTATION, OR ANY COPY
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. White Pine reserves the right at any time to alter prices, features, specifications, capabilities, functions, licensing terms,
release dates, general availability or other characteristics of the commercial release of the software.

3. Title, ownership rights, and intellectual property rights in and to the Software shall remain in White Pine and/or its
suppliers. You agree to abide by the copyright law and all other applicable laws of the United States including, but not
limited to, export control laws. You acknowledge that the Software in source code form remains a confidential trade secret
of White Pine and/or its suppliers and therefore you agree not to modify the Software or attempt to decipher, decompile,
disassemble or reverse engineer the Software, except to the extent applicable laws specifically prohibit such restriction.

4. Copyright. The Software is owned by White Pine and its suppliers, and its structure, organization and code are the
valuable trade secrets of White Pine and its suppliers. The Software is also protected by United States Copyright Law and
International Treaty provisions. You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or
otherwise attempt to discover the source code of the Software. You may use trademarks only to identify printed output
produced by the Software, in accordance with accepted trademark practice, including identification of trademark owner’s
name. Such use of any trademark does not give you any rights of ownership in that trademark. Except as stated above,
this Agreement does not grant you any intellectual property rights in the Software.

5. White Pine may terminate this License at any time by delivering notice to you and you may terminate this License at any
time by destroying or erasing your copy of the Software. In the event of termination, the following sections of this License
will survive: 2, 3, 4, 5, and 6. This License is personal to you and you agree not to assign your rights herein. This License
shall be governed by and construed in accordance with the laws of the State of New Hampshire and, as to matters
affecting copyrights, trademarks and patents, by U.S. federal law. This License sets forth the entire agreement between
you and White Pine.

6. WHITE PINE OR ITS SUPPLIERS SHALL NOT BE LIABLE FOR (a) INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
INDIRECT DAMAGES OF ANY SORT, WHETHER ARISING IN TORT, CONTRACT OR OTHERWISE, EVEN IF WHITE
PINE HAS BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR (b) FOR ANY CLAIM BY ANY OTHER
PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO
THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME STATES DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND
EXCLUSION MAY NOT APPLY TO YOU.

7. ACKNOWLEDGEMENT: YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT,
AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN
THE PARTIES RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT.

Should you have any questions concerning this Agreement, please contact in writing:
White Pine Software, Inc., 542 Amherst Street, Nashua, NH 03063.
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